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chapter 1

Introduction
This document describes new features in 
Pro Tools TDM 6.9 for Pro Tools|HD systems on 
Windows XP or Mac OS X.

System Requirements
For complete system requirements, visit the 
compatibility page of the Digidesign Web site 
(www.digidesign.com/compato).

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it 
has tested and approved. 

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, refer to the latest compatibility informa-
tion on the Digidesign Web site 
(www.digidesign.com/compato).
Pro Tools TDM 6.9 New 
Features
Pro Tools TDM 6.9 includes the following new 
or enhanced features:

System Configuration Updates

• Increase in total number of buses to 128

• Increase in total number of auxiliary tracks 
to 160

Session and Track Features

• Track selection enhancements:

• Selecting a range of tracks

• Selecting or deselecting non-contiguous 
tracks

• Show/Hide Track List selection enhance-
ments:

• Show a range of tracks

• Show or hide non-contiguous tracks

• Regions List selection enhancements:

• Selecting a range of regions

• Selecting or deselecting non-contiguous re-
gions

• Track View enhancements:

• Changing to the next or previous Track 
View
Chapter 1: Introduction 1
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I/O Setup Updates

• I/O Setup dialog interface changes:

• Renamed I/O Setup options and Path tools

• New Track Default Output option supports 
bus paths

• Path selection enhancements in I/O Setup:

• Selecting a range of paths in I/O Setup

• Selecting or deselecting non-contiguous 
paths in I/O Setup

Navigation Features

• Back/Forward commands:

• Back command

• Back and Play command

• Forward command

• Forward and Play command

• Back/Forward Amount preference

• Repeating Back/Forward commands

• Extending selections with Back/Forward 
commands

Playlists and Groups Enhancements:

• Improved grouped playlist synchroniza-
tion

New Plug-Ins and Plug-In Features

• EQ III DigiRack plug-in

• Plug-In menu organization enhancements:

• Organize plug-ins in a Flat List, or by Cate-
gory, Manufacturer, or Category and Man-
ufacturer

• “Organize Plug-In Menus By” pop-up 
menu (Display Preference)

• Effects Category
What’s New in Pro Tools TDM 6.9
New or Enhanced Soloing Features

• New Solo modes:

• SIP (Solo In Place)

• AFL (After Fader Listen)

• PFL (Pre-Fader Listen)

• I/O Setup options for AFL/PFL modes:

• AFL/PFL Path Selector

• AFL/PFL Mutes (Output Path) Selector (for 
systems without a D-Control or D-Com-
mand control surface)

Modified Solo Latch Options

• Latch

• X-OR (Cancels Previous Solos)

• Momentary 

New or Enhanced Automation Features

• “After Write Pass, Switch To…” Automation 
preference:

• Touch

• Latch

• None

• “After Write Pass, Switch To…” Support in 
Trim Modes

• “Stop” Mutes Audio Inputs (When in Auto In-
put)” now called “Mute Record-Armed Tracks 
While Stopped”

• AutoMatch for Latch and Write Automation 
modes (supported Digidesign control surfaces 
only)

• Automation Enable window updates

• Suspend automation on-the-fly updates:

• Switching to any Automation mode from 
Off during playback or record

• Suspending automation on-the-fly

• Track View Selector turns grey when sus-
pending automation.



                   
• Automation fader improvements:

• Stationary faders in all Trim modes

• Join and AutoJoin, for automatic punch-in 
support in Latch mode (with supported 
Digidesign control surfaces)

• Join/AutoJoin indicator in Pro Tools Edit 
window

• Constrain new breakpoints to next or previ-
ous automation value

• Glide Automation

• Automation Write on Stop modes enhance-
ments

• Automation Mute Overwrite/Extend com-
mand

• Write automation to the next breakpoint

Surround Features

• Combined Panning mode buttons

• AutoGlide mode

Changes to Avid Compatibility

• Support for MXF audio import and play-
back

• Support for MXF audio export (DigiTrans-
lator 2.0 required)

• Removal of “Publish as OMFI” command 
from audio export and Bounce to Disk dia-
logs

New Localization Support

• Full Korean and Simplified Chinese local-
ization

• Multilingual application support for 
Pro Tools LE systems (Localized OS on 
Mac OS X only)

New Machine Control Preference

• Set Servo Lock bit at Play (Tamura Support)
Pro Tools TDM 6.9 Control 
Surface Features
Pro Tools TDM 6.9 includes new or enhanced 
support for the following control surfaces:

• D-Command

• D-Control

• ProControl

• Control|24

• Command|8

D-Command

Pro Tools TDM 6.9 adds support for D-Com-
mand, Digidesign’s new mid-sized control sur-
face. 

D-Control

Pro Tools TDM 6.9 adds support for the follow-
ing features with D-Control:

Channel Strip Features

• Option to suppress display of parameter val-
ues when channel encoders or faders are 
touched

• Control of PRE phantom power from encoder 
knob or switch

• Inline Console mode allows control of input 
levels and monitoring levels from a single 
channel strip

• Global controls changed to affect all tracks in 
a session

• Return of controls to default settings
Chapter 1: Introduction 3
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Automation Features

• Automation Mode controls changed to follow 
Do To All and Do To Selected modes on D-
Control

• Access to Automation Write to Start/End/All 
commands from Soft Keys

• Access to Automation Write on Stop modes 
from Auto Write and Soft Keys sections

• Enabling of plug-in automation for all plug-in 
parameters 

Plug-In Features

• Toggling of plug-in active/inactive status di-
rectly from channel strips

• Changing plug-in presets directly from chan-
nel strips

• Copying and pasting of plug-in settings di-
rectly from channel strips

• Saving of plug-in settings directly from D-
Control EQ and Dynamics sections

• Export, storage, and import of session-inde-
pendent Custom Fader Plug-In maps

• One-step clearing of Custom-Fader Plug-In 
maps

Transport and Navigation Features

• Option to focus Transport controls on Time-
line or Edit selections (from Miscellaneous 
Controls)

• Latching behavior for Fast Forward switch 
and Rewind switch

• Nudging of track focus in Focus Channel Strip

• Support for selection of multiple tracks, track 
ranges, and non-contiguous tracks (following 
new Pro Tools 6.9 behavior)

• Dedicated switches for Back, Back and Play, 
Forward, and Forward and Play commands
What’s New in Pro Tools TDM 6.9
Custom Fader Features

• Support for up to 48 Custom Groups

• Dual, independent Custom Fader Banks

• Control of all Custom Fader Bank types from 
Bank Select Matrix and Soft Keys

• Full display of plug-in names or folders

• New Custom Fader Tracks switch allows dis-
play of different track types in Custom Faders

• Insertion of new Custom Group channels at 
any location in a Custom Group

• Option to display hidden tracks in Custom 
Faders section

• Entering Custom Fader Plug-In mode directly 
from top level plug-in view

Soft Keys Section Features

• New Select/MIDI Soft Keys

• Bank Select switch

• Memory Location switch

• MIDI switch

• New Console Preferences Soft Keys

• User switch

• Meter switch

• Operation switch

• New Automation Soft Keys

• AutoMatch switch

• Join switch

• AutoJoin switch

• Action switch (for Write to 
Start/End/All/Next commands and 
Snap Back function)

• Modes switch (for Auto Write to 
Start/All/End/Next On Stop modes)

• Preferences switch (for Match Time and 
Glide Time)



             
• Show/Hide Soft Key supports new Show/Hide 
options by track type

• Soft Key quick exit command

Display and Metering Features

• Gain Reduction Priority meter preference

• Display of full Input, Output, Insert or Send 
Names in Assign Mode

• Close all Workspace Browsers command

• Flop Mode expanded to allow transfer of con-
trols between any two rows of channel strip 
encoders

Monitoring Features

• Dedicated Solo mode controls (AFL/PFL and 
SIP switches)

• Dedicated Solo Latch option controls (Latch, 
Momentary, and X-OR switches)

ProControl Features

Pro Tools TDM 6.9 adds support for the follow-
ing features with ProControl:

• Keyboard shortcuts for Back, Back and Play, 
Forward, and Forward and Play commands

• Keyboard shortcuts for AutoMatch, Snap 
Back, Join and AutoJoin functions

• Keyboard shortcuts for Auto Write to 
Start/All/End On Stop modes

• Support for Pro Tools Solo Latch options
Control|24 Features

Pro Tools TDM 6.9 adds support for the follow-
ing features with Control|24:

• Keyboard shortcuts for Back, Back and Play, 
Forward, and Forward and Play commands

• Keyboard shortcuts for AutoMatch, Snap 
Back, Join and AutoJoin functions

• Keyboard shortcuts for Auto Write to 
Start/All/End On Stop modes

• Support for Pro Tools Solo Latch options

Command|8 Features

Pro Tools TDM 6.9 adds support for the follow-
ing features with Command|8:

• Keyboard shortcuts for Back, Back and Play, 
Forward, and Forward and Play commands

• Keyboard shortcuts for AutoMatch and Snap 
Back functions

• Support for Pro Tools Solo Latch options
Chapter 1: Introduction 5
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Support for Avid Video on 
Pro Tools|HD Systems
Pro Tools TDM 6.9 includes new support for 
Avid video on Pro Tools|HD systems with AVop-
tion|V10 or Avid Mojo with 
Avid Media Station|PT.

New Features for Avid DNA Video 
Peripherals (AVoption|V10 and 
Avid Mojo)
• New Movie track options

• Addition of Record Enable and Offline but-
tons to Movie track

• Additions to Input/Output View for Movie 
track

• Digitize video to Pro Tools Timeline

• Hardware requirements and options

• Configuring the Movie track for digitizing

• Import, playback, and export MXF audio files

• Importing MXF audio into Pro Tools

• Editing MXF audio in Pro Tools

• MXF audio metadata display in DigiBase 
browsers

• Exporting Pro Tools tracks as MXF audio 
files

• Support for AAF sequences referencing Sound 
Designer II audio files 

• Import OMF/AAF files with mixed sample 
rates and/or bit depths

• Optimizations for synchronization, Remote 
mode, and record allocation

• Redefine External Time Code Offset com-
mand

• Changes to minimum sync delay
What’s New in Pro Tools TDM 6.9
New AVoption|V10 Features
• Import and playback of any standard-defini-

tion Avid MXF Video file

• Import and playback of IMX MPEG50 video 
files

• Optical connections between AVoption|V10 
and audio interface no longer required

New Avid Mojo Features
• Windows XP TDM support

• Avid Unity support for Avid Mojo on 
Windows XP

• Recording to and Streaming Media from 
Unity

• Digitizing Video Directly to Unity

New Avid Media Station|PT 
Features
• Send to Pro Tools Export templates

• Video mixdown

• MXF audio support

• Import, playback, and export of all MXF video 
resolutions

• Support for Avid Mojo on Windows XP and 
Mac OS X, including:

• Capture and playback of Mojo-supported 
resolutions 

• Capture audio from 192 I/O audio interface

• Transcode non-Avid Mojo resolutions to 
DV25 for import to Pro Tools



         
chapter 2

What’s New In Pro Tools  TDM 6.9
System Configuration 
Updates

Increase in Total Number of 
Busses to 128

Pro Tools TDM 6.9 provides a total of 128 buses 
for routing signals internally.

Increase in Total Number of 
Auxiliary Tracks to 160

Pro Tools TDM 6.9 provides up to 160 Auxiliary 
Input tracks (aux inputs), which can be used for 
effects returns, external inputs, or submixers.

Session and Track Features

Track Selection Enhancements

Pro Tools 6.9 lets you select a range of contigu-
ous tracks in the Mix or Edit window. In addi-
tion, the keyboard commands for selecting or 
deselecting non-contiguous tracks have 
changed.

Bus paths are defined in the I/O Setup dia-
log, and are available in all supported chan-
nel formats (mono, stereo, or multichan-
nel).
Selecting a Range of Tracks

To select a range of tracks:

1  Click the name of an unhighlighted track in 
its track channel strip.

2  Shift-click an additional track name.

All tracks that occur between the first track se-
lected and the additional track will also be se-
lected.

Selecting or Deselecting 
Non-Contiguous Tracks

To select or deselect non-contiguous tracks, do 
the following:

■ Control-click (Windows) or Command-click 
(Macintosh) track names that are unhighlighted 
to select them.

– or –

■ Control-click (Windows) or Command-click 
(Macintosh) track names that are highlighted to 
deselect them.

In previous versions of Pro Tools, non-con-
tiguous tracks were selected or deselected us-
ing Shift-click.
Chapter 2: What’s New In Pro Tools  TDM 6.9 7
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Show/Hide Track List Selection 
Enhancements

Pro Tools 6.9 provides new keyboard commands 
for selecting and deselecting a range of track 
names in the Show/Hide Track List. In addition, 
the keyboard commands for selecting and dese-
lecting non-contiguous track names in the list 
have changed.

Show a Range of Tracks:

To show a range of tracks:

1  Click the name of an unhighlighted track 
name in the Show/Hide Track List.

2  Shift-click an additional track name.

All track names that occur between the first 
track name selected and the additional track 
name will also be selected.

To show or hide a range of tracks in the 
Show/Hide List with the Marquee:

1  Press and hold Control (Windows) or Com-
mand (Macintosh).

2  Move the cursor to the left of a track name un-
til the Marquee with a small “+” symbol ap-
pears.

• To show tracks, the Marquee should be to 
the left of an unhighlighted track name.

• To hide tracks, the Marquee should be to 
the left of a highlighted track name.

3  Click on the track name and drag up or down 
(to show or hide the track and the tracks imme-
diately above or below it).

You can also select a range of tracks by 
moving the cursor to the left of the track 
names until the Marquee appears, and 
dragging the Marquee around the track 
names you want to select.
What’s New in Pro Tools TDM 6.9
Show or Hide Non-Contiguous Tracks

To show or hide non-contiguous tracks, do the 
following:

■ Control-click (Windows) or Command-click 
(Macintosh) track names that are unhighlighted 
to select them.

– or –

■ Control-click (Windows) or Command-click 
(Macintosh) track names that are highlighted to 
deselect them.

Regions List Selection 
Enhancements

Pro Tools 6.9 provides new keyboard commands 
for selecting and deselecting a range of contigu-
ous regions in the Audio or MIDI Regions List. 
In addition, the keyboard commands for select-
ing and deselecting non-contiguous regions 
have changed.

Selecting a Range of Regions

To select a range of regions in a Regions List:

1  Click the name of a region in a Regions List.

2  Shift-click an additional region name.

All regions that occur between the first region 
selected and the additional region will also be 
selected.

In previous versions of Pro Tools, non-con-
tiguous track names were selected or dese-
lected using Shift-click.

You can also select a range of regions by 
moving the cursor to the left of the region 
names until the Marquee appears, and 
dragging the Marquee around the regions 
you want to select.



To select or deselect a range of regions with the 
Marquee:

1  Press and hold Control (Windows) or Com-
mand (Macintosh).

2  Move the cursor to the left of the region name 
until the Marquee icon with a small “+” symbol 
appears.

• To select regions, the Marquee should be to 
the left of an unhighlighted region name.

• To hide regions, the Marquee should be to 
the left of a highlighted region name.

3  Click on the region name and drag up or 
down (to select or deselect regions immediately 
above or below the region name).

Selecting or Deselecting Non-
Contiguous Regions

To select or deselect non-contiguous regions, do 
the following:

■ Control-click (Windows) or Command-click 
(Macintosh) region names that are unhigh-
lighted to select them.

– or –

■ Control-click (Windows) or Command-click 
(Macintosh) region names that are highlighted 
to deselect them.

In previous versions of Pro Tools, non-
contiguous regions were selected or dese-
lected using Shift-click.
Track View Enhancements

Changing to the Next or Previous 
Track View

For audio, Auxiliary Input, and MIDI tracks, you 
can change to the next or previous Track View.

When changing to the next or previous Track 
View, Track View list ordering is maintained as 
shown in the Track View Selector.

Track View set to Waveform for audio track

Toggling between pre-defined common 
Track Views is still supported. See the 
Pro Tools Reference Guide.

Audio Track View Selector list 

MIDI Track View Selector list
Chapter 2: What’s New In Pro Tools  TDM 6.9 9



10
To change to the previous or next Track View:

1  Click in the track you want to change. To 
change views on multiple tracks, Shift-click or 
drag the Selector to select additional tracks, or 
select a group.

2  Do one of the following:

• To change to the previous or next Track 
View on all selected tracks, press Con-
trol+Start (Windows) or Control+Com-
mand (Macintosh) and the Left or Right 
Arrow.

– or –

• To change to the previous or next Track 
View on all tracks, press Control+Alt+Start 
(Windows) or Control+Option+Command 
(Macintosh) and the Left or Right Arrow.

Auxiliary Track View Selector list

Track Views at the beginning of the list 
(such as Blocks for audio or MIDI tracks) 
cannot be changed to the previous Track 
View. Tracks Views at the end of the list 
(such as a MIDI controllers option) cannot 
be changed to the next Track View.
What’s New in Pro Tools TDM 6.9
I/O Setup Updates

I/O Setup Dialog Interface 
Changes

The I/O Setup dialog has been updated to sup-
port new AFL/PFL output choices (see “New Solo 
Modes” on page 15).

I/O Setup options and path tools in the I/O 
Setup dialog have been repositioned, and the 
following controls have been renamed:

• Meter Path Selector is now called Control-
ler Meter Path.

• Audition is now called Audition Paths.

• Default Output is now called New Track 
Default Output.

New Track Default Output Supports Bus Paths

The New Track Default Output assignment can 
now be set to bus paths, as well as output paths.

Path Selection Enhancements in 
I/O Setup

Pro Tools 6.9 lets you select a range of contigu-
ous paths in the I/O Setup dialog. In addition, 
the keyboard commands for selecting or dese-
lecting non-contiguous paths have changed.

I/O Setup options and path tools

New Track Default Output pop-up menu (bus selected)



Selecting a Range of Paths

To select a range of paths in the I/O Setup dialog:

1  Click the path name.

2  Shift-click an additional path name.

All paths that occur between the first path name 
selected and the additional path name will also 
be selected.

Selecting or Deselecting 
Non-Contiguous Paths

To select or deselect non-contiguous paths, do the 
following:

■ Control-click (Windows) or Command-click 
(Macintosh) path names that are unhighlighted 
to select them.

– or –

■ Control-click (Windows) or Command-click 
(Macintosh) path names that are highlighted to 
deselect them.

Navigation Features

Back/Forward Commands

Pro Tools provides four Back/Forward com-
mands (sometimes called “rollback”) for mov-
ing the playback location in the Edit window. 
The length of the move is defined by the 
Back/Forward Amount set in the Operation page 
of the Setups > Preferences window.

In previous versions of Pro Tools, non-
contiguous paths were selected or deselected 
using Shift-click.
You can also move the playback location in 
multiple increments by repeating the command 
(See “Repeating Back/Forward Commands” on 
page 12).

Back Moves the playback location backwards by 
the Back/Forward Amount.

Back and Play Moves the current playback loca-
tion backwards by the Back/Forward Amount 
and automatically begins playback.

Forward Moves the playback location forwards 
by the Back/Forward Amount.

Forward and Play  Moves the current playback 
location forward by the Back/Forward Amount 
and automatically begins playback.

Setting the Back/Forward Amount

The length of the Back/Forward move is deter-
mined by the Back/Forward Amount in the Op-
eration page of the Setups > Preferences win-
dow.

To configure the Back/Forward Amount:

1  Choose Setups > Preferences and click the Op-
eration tab.

The timebase of the Back/Forward Amount set-
tings follows the main time scale by default, or 
you can uncheck Follow Main Time and select 
any of the following timebase formats:

• Bars:Beats

• Min:Sec

• Time Code

• Feet+Frames

• Samples

Back/Forward commands also work when 
controlling a 9-pin device. See the Machine-
Control Guide for details.
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2  Do one of the following:

• Select a preset amount in the Back/Forward 
Amount pop-up menu.

– or –

• In the Back/Forward Amount field, enter in 
a custom amount.

Using Back or Forward Commands

To move the playback location backwards by the 
Back/Forward Amount:

■ Press Control (Windows) or Command (Mac-
intosh), and click Rewind in the Transport win-
dow.

To move the playback location forwards by the 
Back/Forward Amount:

■ Press Control (Windows) or Command (Mac-
intosh), and click Fast Forward in the Transport 
window.

To move the playback location backwards by the 
Back/Forward Amount and then begin playback:

■ Press Control+Alt (Windows) or Com-
mand+Option (Macintosh), and click Rewind in 
the Transport window

To move the playback location forwards by the 
Back/Forward Amount and then begin playback:

■ Press Control+Alt (Windows) or Com-
mand+Option (Macintosh), and click Fast For-
ward in the Transport window

Repeating Back/Forward Commands

All the Back/Forward commands can be re-
peated in order to increase the amount of the to-
tal Back or Forward move.
What’s New in Pro Tools TDM 6.9
To repeat Back/Forward moves:

1  Press and hold Control (Windows) or Com-
mand (Macintosh).

2  Click Rewind or Fast Forward the number of 
times you want to repeat moving the playback 
location backwards or forwards by the Back/For-
ward Amount.

Extending Selections with Back or Back 
and Play Commands

The Back or Back and Play commands can be 
used to extend a selection backwards by the 
length of the Back/Forward Amount. 

To extend a selection with Back or Back and Play 
commands:

1  Configure the Back/Forward Amount. 
(See“Setting the Back/Forward Amount” on 
page 11.)

2  With the Selector, drag within a track to make 
a selection.

3  Do one of the following:

• To extend the selection backwards by the 
Back/Forward Amount, press Shift+Control 
(Windows) or Shift+Command (Macin-
tosh) and click Rewind in the Transport 
window.

– or –

• To extend the selection backwards by the 
Back/Forward Amount and then begin 
playback, press Shift+Control+Alt (Win-
dows) or Shift+Command+Option (Macin-
tosh) and click Rewind in the Transport 
window.

Although you cannot extend a selection 
with the Forward or Forward and Play com-
mands, you can use the following proce-
dures with Forward or Forward and Play to 
move the start point of a current selection.



Improved Grouped Playlist 
Synchronization
Creating new playlists with grouped tracks auto-
matically increments the suffixes of the playlist 
names for each track of the active group. This 
lets you revert back to an earlier take by switch-
ing the playlist takes by group. 

Using this method, you can add new tracks to 
the existing group and the suffixes for their 
playlist names will be synchronized with the 
original tracks. 

In Pro Tools 6.9, “empty” playlists will be auto-
matically created to keep the playlist takes in 
sync when switching back to the earliest playlist 
takes in the group.

To keep your playlist names and performances 
synchronized (sample workflow):

1  Create new tracks and group them together.

2  Make sure the group is enabled.

3  Create a new playlist (by clicking the Playlist 
Selector in one of the tracks in the group and 
choosing New). The default suffix will now be 
“.01”—signifying take 1.

4  Record take 1, then create a new playlist. The 
playlists on all tracks in the group will be incre-
mented to “.02.”

5  Create new tracks (for example, for an addi-
tional musician or microphones), then add 
these tracks to the group.

6  Increment all the playlists by clicking the 
Playlist Selector in one of the tracks in the group 
and choosing New.

All the playlists will now have the same suffix 
appended to them. (Creating additional play-
lists in any of the group tracks will increment 
their playlists to keep them in sync.)
7  If you want to hear the .01 take on the first 
group of tracks, you can switch any playlist in 
the group back to playlist .01.

All tracks in the group have playlists numbered 
with .01 suffixes (even those tracks that were 
added to the original group after the earlier 
takes). Empty playlists are automatically created 
on these newly-added members so that playlist 
numbers match across all members of the 
group.

New EQ III DigiRack Plug-In
EQ III is a new DigiRack EQ plug-in that pro-
vides the following features: 

1 Band, 2–4 Band, and 7 Band Operation Flexi-
ble EQ types for maximum CPU and DSP effi-
ciency. 

Interactive Display Editable frequency display 
for quickly viewing or editing the EQ curve.

Double Precision Arithmetic Enhanced 48-bit 
processing dithered to 24-bit output.

Control Surface Support Designed to fully com-
pliment the EQ sections of supported Digidesign 
control surfaces.

EQ III plug-in (7-band shown)
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EQ III is available in TDM, RTAS, and AudioSuite 
formats as a mono or multi-mono plug-in.

New Plug-In Features

Plug-In Menu Organization 
Enhancements

In Pro Tools 6.9, you can customize how plug-in 
lists (plug-in menus) are organized in the Insert 
Selector or Plug-In Selector.

For more information, see the DigiRack 
Guide.

Plug-ins organized by Category (using the Insert 
Selector)

Plug-ins organized by Manufacturer (using the Plug-In 
Selector)
What’s New in Pro Tools TDM 6.9
Use the “Organize Plug-In Menus By” pop-up 
menu in the Display Preferences page to orga-
nize plug-in menus in a Flat List (with plug-ins 
in alphabetical order), or by Category, Manufac-
turer, or Category and Manufacturer. 

“Organize Plug-In Menus By Pop-Up Menu”

Flat List Organizes plug-ins in a single list, in al-
phabetical order.

Category Organizes plug-ins by process category 
(such as EQ, Dynamics, and Delay), with indi-
vidual plug-ins listed in the category submenus. 
Plug-ins that do not fit into a standard category 
(such as the DigiRack Signal Generator), or 
third-party plug-ins that have not had a cate-
gory designated by their developers, appear in 
the Other category. Plug-ins can appear in more 
than one category. 

Manufacturer Organizes plug-ins by their manu-
facturer (such as Digidesign, Eventide, Line 6, 
and McDSP), with individual plug-ins listed in 
the manufacturer submenus. Plug-Ins that do 
not have a Manufacturer defined will appear in 
the “Other” manufacturer folder. 

Most Digidesign-distributed third party plug-ins 
will be grouped under Digidesign when view by 
Manufacturer is enabled.

Category and Manufacturer Organizes plug-ins 
in two levels of menus. The top menus display 
plug-ins by process category (such as EQ, Dy-
namics, and Delay), with individual plug-ins 
listed in the category submenus. The bottom 
menus display plug-ins by manufacturer (such 
as Digidesign, Eventide, Line 6, and McDSP), 
with individual plug-ins listed in the manufac-
turer submenus.

The “Organize Plug-In Menus By” pop-up 
menu has replaced the “Organize Plug-Ins 
By Category” option.



To select how plug-ins are organized:

1  Open or create a session. 

2  Choose Setups > Preferences, and click the 
Display tab.

3  Click the “Organize Plug-In Menus By” pop-
up menu, and select one of the view options.

4  Click Done.

The current “Organize Plug-In Menus By” set-
ting determines how plug-ins will be organized 
for all sessions.

Control Surface Support

Digidesign control surfaces with multi-color 
LCDs (such as D-Control) indicate plug-ins as 
follows:

• Plug-in categories (such as EQ) and plug-in 
manufacturers (such as Digidesign) are in-
dicated in green text.

• Specific plug-ins located in the plug-in sub-
folders (such as EQ III in the EQ subfolder) 
are indicated in yellow (amber) text.

Control surfaces with single-color displays (such 
as Command|8) do not indicate plug-in view 
choices. They display contents of a plug-in 
folder as a single list of plug-ins. (While control 

Display page of the Setups > Preferences window
surfaces with single-color displays do not indi-
cate plug-in choices, Pro Tools software contin-
ues to display plug-ins according to the “Orga-
nize Plug-Ins Menu By” setting.)

New Effects Category

When the “Organize Plug-In Menus By” option 
is set to Category or Category and Manufacturer, 
an Effects subfolder appears in the plug-ins 
menu if you have any Effect plug-ins installed.

The Effects subfolder organizes special effects, 
multi-effect processors, and other plug-ins. All 
plug-ins that specify their plug-in category as an 
“Effects” type will be displayed within the Ef-
fects subfolder.

New or Enhanced Soloing 
Features

New Solo Modes

In previous versions of Pro Tools, the Solo func-
tion works by muting other tracks. In Pro Tools 
6.9, the Solo button isolates signals for monitor-
ing in three different modes, as follows:

SIP (Solo In Place) This is how the Solo button 
worked in previous versions of Pro Tools. The 
Solo button mutes other tracks. When this 
mode is enabled, tracks can be solo safed (see 
the Pro Tools Reference Guide for details on using 
solo safe).

The Effects subfolder only appears on sys-
tems that have Effects plug-ins installed.

Plug-ins can appear in more than one cate-
gory.
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AFL (After Fader Listen) The Solo button routes 
the track’s post-fader/post-pan signal to the 
AFL/PFL Path output. The AFL/PFL Path is con-
figured in the Output page of the I/O Setup dia-
log (see “AFL/PFL Path Selector” on page 17). 

With AFL, the level you hear is dependent on 
the fader level for that track. Additionally, there 
is a separate master level setting for AFL that af-
fects the output of any or all tracks you solo in 
AFL mode (see “Setting AFL or PFL Path Levels” 
on page 17). This level setting is independent of 
the PFL level setting.

PFL (Pre-Fader Listen) The Solo button routes 
the track’s pre-fader/pre-pan signal to the 
AFL/PFL Path output. The AFL/PFL Path is con-
figured in the Output page of the I/O Setup dia-
log (see “AFL/PFL Path Selector” on page 17). 

With PFL, the fader level and pan are ignored, 
and the level you hear is dependent on the sig-
nal’s recorded level. Additionally, there is a sep-
arate master level setting for PFL that affects the 
output of any or all tracks you solo in PFL mode 
(see “Setting AFL or PFL Path Levels” on 
page 17). This level setting is independent of the 
AFL level setting.

AFL and PFL Solo mode require the Sur-
round Mixer plug-in (see the Pro Tools Ref-
erence Guide for installation information).

AFL and PFL Solo mode require the Sur-
round Mixer plug-in (see the Pro Tools Ref-
erence Guide for installation information).

If Mutes Frees Assigned Voice is enabled, 
muted tracks will not be audible in PFL 
mode.
What’s New in Pro Tools TDM 6.9
To select a Solo mode:

1  Choose Operations > Solo Mode, and select 
SIP, AFL, or PFL.

DSP Usage when Using AFL or PFL Mode

AFL and PFL are accomplished by Pro Tools cre-
ating a “behind the scenes” mixer to route the 
signal to the chosen AFL/PFL Path. Depending 
on the size of your main mixer, Pro Tools will 
devote a substantial portion of its available DSP 
when using AFL/PFL mode.

Un-declaring the AFL/PFL Path will free up all 
DSP resources previously used for AFL/PFL 
mode.

Using AFL/PFL on Pro Tools Systems 
with a D-Control or D-Command

AFL/PFL is optimized for Pro Tools systems us-
ing a D-Command or D-Control control surface, 
where the XMON automatically switches its 
monitor source between the main output and 
the AFL/PFL output from Pro Tools.

The Solo mode for all soloed tracks can be 
changed “on-the-fly” from any Solo mode to 
either SIP or AFL. Previously soloed tracks 
will switch their solo behavior to the new 
mode.

Switching the Solo mode for all soloed 
tracks “on-the-fly” to PFL will clear all pre-
viously soloed tracks before entering PFL 
mode. This will prevent potentially large 
boosts in level.

For more information on using XMON and 
AFL/PFL, see your control surface guide.



Using AFL/PFL on Pro Tools Systems 
without D-Control or D-Command

If you are not using a D-Control or D-Command 
control surface, your regular Pro Tools output 
path is not necessarily muted when you send a 
signal to the AFL/PFL Path. If you need the main 
signal to automatically mute when an AFL/PFL 
signal is invoked, you need to do the following: 

1  Configure the output path for AFL or PFL so-
loed tracks (“AFL/PFL Path Selector” on 
page 17).

2  Select the main output path that will mute 
when you solo a track in AFL or PFL mode (see 
“AFL/PFL Mutes (Output Path) Selector” on 
page 18).

3  Set up your hardware to monitor both the 
main and AFL/PFL paths simultaneously.

When AFL or PFL is selected as a Solo mode and 
a track is soloed, the main output path will mute 
and the AFL/PFL signal will appear at the 
AFL/PFL Path for monitoring.

I/O Setup Options for AFL/PFL

I/O Setup provides two selectors for configuring 
AFL/PFL solos: AFL/PFL Path Selector and 
AFL/PFL Mutes (Output Path) Selector. 

A separate master AFL/PFL Path level for all AFL 
solos and all PFL solos is set in the Mix or Edit 
window.

The current AFL/PFL settings (including the 
path level) are saved with the Pro Tools session 
file, and are also the default settings for new ses-
sions.
AFL/PFL Path Selector

Tracks soloed in AFL or PFL Solo mode are 
routed to the current AFL/PFL Path, as set with 
the AFL/PFL Path Selector.

To select the AFL/PFL Path output:

1  Choose Setups > I/O Setup.

2  Click the Output tab to display the Output 
page.

3  Select a path from the AFL/PFL Path Selector.

4  Click OK to close the I/O Setup dialog.

Setting AFL or PFL Path Levels

You can set a separate master AFL/PFL Path level 
for all AFL solos and all PFL solos.

To set the AFL/PFL Path level for AFL or PFL solos:

1  Choose Operations > Solo Mode, and select a 
Solo mode, as follows:

• If you want to set the level for AFL solos, se-
lect AFL.

– or –

• If you want to set the level for PFL solos, se-
lect PFL.

2  In the Mix or Edit window, Control-click 
(Windows) or Command-click (Macintosh) a 
Solo button on any track.

If you do not see the AFL/PFL Path Selector, 
check that you have installed the Surround 
Mixer.

Selecting None as the AFL/PFL Path dis-
ables AFL and PFL Solo modes. When 
None is selected, AFL and PFL cannot be 
used.

Tracks do not need to be soloed to have the 
master AFL/PFL Path level adjusted. 
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3  Adjust the AFL/PFL Path fader.

4  Click on the new fader position (or press Esc) 
to close the fader display.

AFL/PFL Mutes (Output Path) Selector

(Systems without a D-Control or D-Command 
Control Surface)

If you are not using a D-Control or D-Command 
control surface, your regular Pro Tools output 
path can be muted when you send a signal to 
the AFL/PFL Path. The muted path is set with 
the AFL/PFL Mutes (Output Path) Selector.

To set which output path is muted when tracks are 
soloed in AFL or PFL Solo mode:

1  Choose Setups > I/O Setup.

2  Click the Output tab to display the Output 
page.

3  Select a path from the AFL/PFL Mutes (Output 
Path) Selector.

4  Click OK to close the I/O Setup dialog.

Solo Latch Options
In the Operation page of the Setups > Prefer-
ences window, the Latch Solo Buttons option 
has been replaced with the Solo Latch section, as 
follows:

The maximum fader gain for the AFL/PFL 
Path is either +6 dB or +12 dB, based on the 
session’s Fader Gain setting (which is set 
when you create a session).

To set the AFL/PFL Path level to 0 dB, Con-
trol-Start-click (Windows) or Control-Com-
mand-click (Macintosh) any Solo button.
What’s New in Pro Tools TDM 6.9
Latch When this option is selected, pressing 
subsequent Solo buttons does not cancel previ-
ously pressed solos.

X–OR (Cancels Previous Solos) When this op-
tion is selected, pressing subsequent Solo but-
tons cancels previous solos.

Momentary (Pro Tools TDM Only with Supported 
Control Surfaces Only) When this option is se-
lected, the Solo button is not sticky. When the 
Solo button is held down, the track is soloed. 
Additional tracks can be soloed by touching 
their Solo buttons (as long as at least one Solo 
button is held down). When no Solo button is 
held down, all soloed tracks will unsolo.

To select a Solo Latch option:

1  Choose Setups > Preferences and click the Op-
eration page.

2  Select a Solo Latch option.

To override X–OR mode and solo more than 
one track at a time, press and hold the Solo 
button on the first track. Subsequently 
pressed Solo buttons will latch.

Operation page of the Setups > Preferences window



Using Momentary Solo Latch

(Pro Tools TDM Systems with Supported 
Control Surfaces Only)

In Momentary Solo Latch mode, you can tem-
porarily latch solos (adding them to the mix of 
soloed tracks), then quickly unlatch them with-
out having to deselect each soloed track.

To temporarily latch solos:

1  Choose Setups > Preferences and click the Op-
eration page.

2  In the Solo Latch section, select Momentary, 
and click Done.

3  Press and hold the Solo button on the first 
track that will be soloed.

4  While still holding the first Solo button, press 
additional Solo buttons. Solo buttons will re-
main soloed as long as one Solo button is held.

New or Enhanced Automation 
Features

Automation Preferences

“After Write Pass, Switch To” 
Preference

In the Automation Preferences page, the “After 
Write Pass, Switch To” preference has replaced 
the “Write Switches To Touch After Pass” prefer-
ence.

As long as at least one Solo button is held 
down, all the solos will remain latched.
“After Write Pass, Switch To” selects the Auto-
mation mode that Pro Tools tracks automati-
cally switch to after an automation pass in Write 
mode. You can choose to switch to Touch or 
Latch mode, or stay in Write mode by selecting 
No Change.

To configure “After Write Pass, Switch To”:

1  Choose Setups > Preferences and click the 
Automation tab.

2  Select an “After Write Pass, Switch To” option 
(Touch, Latch, or No Change).

3  Click Done.

“After Write Pass, Switch To” Support in Trim 
Modes

“The After Write Pass, Switch To” setting also af-
fects Write/Trim mode. After a Write/Trim auto-
mation pass, the Write/Trim tracks automati-
cally switch to Latch/Trim, Touch/Trim, or 
remain in Write/Trim.

Automation page of the Setups > Preferences window

In previous versions of Pro Tools, tracks did 
not switch to the Trim version of Touch 
when “Write Switches To Touch After 
Pass” was enabled.
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“Mutes Record-Armed Tracks 
While Stopped” Option

In the Operation page of the Setups > Prefer-
ences windows, the “Stop” Mutes Audio Inputs 
(When in Auto Input)” option is now called 
“Mute Record-Armed Tracks While Stopped.” 

AutoMatch for Latch and Write 
Automation Modes
(Supported Digidesign Control Surfaces Only)

In Pro Tools 6.9, an AutoMatch Time can be ap-
plied to Latch or Write automation modes (sup-
ported Digidesign Control Surfaces only). Refer 
to Chapter 3, “What’s New In Pro Tools 6.9 
Control Surfaces.”

AutoMatch Time is the amount of time it takes 
for a fader to return (by ramping up to down) to 
the level of automation still on the track, as the 
automation pass ends.

The AutoMatch Time value is set in the Auto-
mation Preferences page.

The triangular AutoMatch indicators at the bot-
tom left of each channel strip in the Mix win-
dow light to indicate the direction the fader will 
automatically move.

In previous versions of Pro Tools, Auto-
Match could only be applied to Touch 
mode.

See the Pro Tools Reference Guide for more 
details on AutoMatch.
What’s New in Pro Tools TDM 6.9
Automation Enable Window 
Updates

The Automation Enable window has been up-
dated with the following buttons:

AutoJoin Button (Latch Mode Only with Supported 
Digidesign Control Surfaces) Lets you automati-
cally resume recording in Latch mode. AutoJoin 
can be enabled from a supported Ethernet-based 
control surface, or from Pro Tools if a supported 
control surface has been declared. See “AutoJoin 
with Latch Mode” on page 21.

Write to Next Breakpoint Buttons Let you write 
current automation values from the insertion 
point to the next written breakpoint, while per-
forming an automation pass. See “Writing Auto-
mation to the Next Breakpoint” on page 27.

Suspend Automation Updates

Suspending Automation On-The-Fly

Pro Tools 6.9 lets you suspend or unsuspend au-
tomation on-the-fly (without having to stop the 
transport), as follows:

◆ Any automation mode can be switched from 
Off to another automation mode during play-
back or record.

◆ Playback of automation can be suspended or 
unsuspended on-the-fly.

New buttons in the Automation Enable window

Write to Next Breakpoint button

Write to Next Breakpoint on Stop button

AutoJoin button



Track View Selector Enhancement when 
Suspending Automation

In Pro Tools 6.9, the Track View Selector turns a 
darker grey when Automation is suspended.

Automation Fader Improvements

Stationary Faders in All Trim Modes

Read/Trim, Touch/Trim, and Latch/Trim have 
been updated with trim features that were previ-
ously only available with Write/Trim.

In Pro Tools 6.9, all Trim modes behave the 
same when they are first enabled (before the au-
tomation pass). The volume and send level fad-
ers are disengaged from displaying and follow-
ing existing automation data, so you do not 
have to chase them during playback or record-
ing. Faders are automatically positioned at 0 dB, 
where no trimming occurs (they start with a 
delta value of zero).

If you invoke an AutoMatch command once 
you have moved the fader in Latch/Trim or 
Write/Trim mode, the fade will glide out, but 
the fader position represents the delta being ap-
plied to the underlying automation already on 
the track. See the Pro Tools Reference Guide for 
more information on Trim modes and Auto-
Match.

Track View Selector with automation suspended

See the Pro Tools Reference Guide for de-
tails on suspending automation.

Track View Selector
AutoJoin with Latch Mode

(Latch Mode with Supported Digidesign 
Control Surfaces Only)

Pro Tools provides two different methods to re-
sume writing automation on controls that were 
active at the point where the transport stopped:

AutoJoin Lets you automatically resume writing 
automation in Latch mode. AutoJoin can be en-
abled from a supported Ethernet-based control 
surface, or from Pro Tools if a supported control 
surface has been declared.

Join Lets you manually resume writing automa-
tion in Latch mode. Join is available only with 
Digidesign-supported control surfaces.

To enable AutoJoin from a control surface or 
manually resume writing with Join, see “What’s 
New In Pro Tools 6.9 Control Surfaces” on 
page 33.

To enable AutoJoin from Pro Tools:

1  Open the Automation Enable window.

2  Click AutoJoin in the Automation Enable win-
dow.

AutoJoin button in the Automation Enable window

See “What’s New In Pro Tools 6.9 Control 
Surfaces” on page 33 for details on using 
Join and AutoJoin with a control surface.

AutoJoin button
Ch
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AutoJoin Indicator

After a Latch automation pass with AutoJoin en-
abled, the AutoJoin indicator appears in the 
Pro Tools Edit window.

The AutoJoin indicator is a red line that signifies 
the point where the last automation pass was 
stopped, and the point where the “join” will au-
tomatically occur on all tracks that were writing 
during that previous pass. When automation 
writing is resumed from this point, the line dis-
appears.

AutoJoin indicator in the Edit window (Middle track 
active at time of stop)

To use Join or AutoJoin to resume writing 
on controls that were writing when the 
transport stopped, restart the transport be-
fore the AutoJoin indicator.

AutoJoin indicator
What’s New in Pro Tools TDM 6.9
Constrain New Breakpoints to 
Next or Previous Automation 
Value

In Pro Tools 6.9, new automation breakpoints 
can be constrained and written to the same 
value as the next or previous breakpoint.

To write a new breakpoint to the next automation 
value:

■ Press and hold Control (Windows) or Com-
mand (Macintosh) while writing a breakpoint 
(by clicking with the Grabber in a track’s Auto-
mation Playlist).

To write a new breakpoint to the previous 
automation value:

■ Press and hold Control+Alt (Windows) or 
Command+Option (Macintosh) while writing a 
breakpoint (by clicking with the Grabber in a 
track’s Automation Playlist).

Constraining and writing new breakpoints (at Marker 1)

Original automation

After write to previous breakpoint

After write to next breakpoint



Glide Automation

The Glide Automation commands let you man-
ually create an automation transition (or glide) 
from an existing automation value to a new 
one, over a selected area.

To apply a Glide Automation to the current 
automation parameter type:

1  In the Automation Enable window, make sure 
the automation type is write-enabled.

2  Click the Track View Selector to choose the au-
tomation type you want to automate. 

3  Drag with the Selector in the track to select 
the area you want to write the glide to.

4  Change the automation parameter to the 
value desired at the end of the selection. For ex-
ample, to glide automation volume to –Infinity, 
move the Volume Fader to –Infinity.

5  Choose Edit > Glide Automation > To Current 
Parameter.

To do a Glide Automation to all current enabled 
parameters:

1  In the Automation Enable window, make sure 
the automation types are write-enabled.

2  In each track you want to automate, click the 
Track View Selector and select from the pop-up 
menu the automation type you want to auto-
mate.

When gliding multiple parameters at the 
same time, such as with the Surround Pan-
ner or plug-ins, use the Glide Automation > 
To All Current Parameters option.

You can also press Alt+ Forward Slash (“/”) 
(Windows) or Option+Forward Slash (“/”) 
(Macintosh).
3  With the Selector, click and drag horizontally 
to include all the tracks you want to automate in 
a selection (drag vertically to define the time 
range).

4  In each track you want to automate, change 
the automation parameter to the value desired 
at the end of the selection.

5  Choose Edit > Glide Automation > To All Cur-
rent Parameters.

Glide Automation Considerations

When an Glide Automation is applied to auto-
mation data, it behaves as follows:

• When a selection is made, the automation 
value at the start of the selection is the start 
point of the Glide Automation and the end of 
the selection is the end point of the Glide 
Automation. The Glide Automation that is 
created between the two is based on the 
length of the selection and the end value that 
is selected.

• If a selection is made and automation data ex-
ists before the start of the selection, automa-
tion breakpoints are written at the start and 
end points of the Glide Automation.

• If automation breakpoints follow the selec-
tion, they are not changed, but the value se-
lected for the end of the selection is written 
from the end point up until the next break-
point.

• If no automation breakpoints follow the selec-
tion, the value selected for the end of the se-
lection is written to the end of the track.

You can also press Alt+ Shift+Forward 
Slash (“/”) (Windows) or Op-
tion+Shift+Forward Slash (“/”) (Macin-
tosh).
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• If no selection is made, a breakpoint is written 
to the current location, and the value selected 
for the Glide Automation is written to the 
next breakpoint.

Automation Write on Stop Modes 
Enhancements

In Pro Tools 6.9, when Write to Start, End, or All 
On Stop mode is enabled, the chosen action will 
be performed automatically after a valid auto-
mation pass, and the Write On Stop mode will 
then be disabled.

Write on Stop modes can also be configured to 
remain enabled after a valid automation pass.

To configure Write on Stop modes to disable after 
an automation pass

1  Open the Automation Enable window.

2  Click to enable one of the Write On Stop 
modes (Start, End, or All).

The enabled Write on Stop arrow will appear in 
blue.

In previous versions of Pro Tools, Write On 
Stop always remained enabled after a valid 
automation pass.

Write on Stop buttons in the Automation Enable window

Write on Stop buttons
What’s New in Pro Tools TDM 6.9
To configure Write on Stop modes to remain 
enabled after an automation pass:

1  Open the Automation Enable window.

2  Press Alt (Windows) or Option (Macintosh) 
and click one of the Write On Stop modes (Start, 
End, or All) to enable the Write On Stop mode.

The enabled Write on Stop arrow will appear in 
red.

Mute Automation 
Overwrite/Extend Command

The Mute Overwrite/Extend command lets you 
overwrite or extend an existing mute event in 
real-time, without changing the current mute 
state.

A mute event can be overwritten when the auto-
mation pass begins before the first mute event 
and ends after the second event. In this case, the 
current on/off state of the mute is maintained.

Overwriting a mute automation event

mute on event overwritten

Original mute automation
(mute off, mute on, mute off)



A mute event can be extended when the auto-
mation pass begins before an on or off event and 
stops before the end of the second event.

Mute Overwrite/Extend is supported in Touch 
and Latch mode, as follows:

Touch Mode Writes the current state as long as 
the mute button is held.

Latch Mode Writes the current state until you 
stop or AutoMatch out (with supported Digi-
design control surfaces only).

Extending a mute automation event

Mute Overwrite/Extend is supported by 
Write To Start/End/All commands. For 
more information on Write to Start/End/All 
commands, see the Pro Tools Reference 
Guide.

mute off event extended (up to automation pass end)

Original mute automation
(mute off, mute on, mute off)
To overwrite a mute state on one or more tracks:

1  Choose Windows > Automation Enable. 

2  Make sure mute is write-enabled.

3  In the Mix or Edit window, click the Auto-
mation Mode Selector of the track you want to 
overwrite the mute state, and set the Auto-
mation mode to Touch or Latch mode.

4  In each track you want to automate, click the 
Track View Selector and select mute.

5  Place the cursor before the start of the mute 
event you want to overwrite.

6  Begin playback.

Mute button in the Automation Enable window

To overwrite mute states on multiple tracks, 
set all tracks to the same Automation mode.

Placing the cursor before the start of a mute event

Mute button enabled

Example: Place cursor here, before start of mute event
Ch
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7  Press Control (Windows) or Command (Mac-
intosh) and the track Mute button before the 
start of the mute event you want to overwrite.

8  After the end of the second mute event, re-
lease the key and the Mute button.

9  When you have finished the automation pass, 
click Stop.

To extend a mute state on a track:

1  Choose Windows > Automation Enable. 

2  Make sure mute is write-enabled.

To overwrite mute states on multiple tracks, 
press Alt+Control (Windows) or Op-
tion+Command (Macintosh) and the Mute 
button on one of the tracks to be automated.

With Touch mode, you have to hold the 
Mute button for the duration of the write.

Stopping automation after the end of a mute event

Example of mute state overwritten

Example: Stop automation pass here, after end of mute event

mute on state overwritten
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3  In the Mix or Edit window, click the Auto-
mation Mode Selector of the track you want to 
automate, and select Touch or Latch mode.

4  In each track you want to automate, click the 
Track View Selector and select mute.

5  Place the cursor before the start of the mute 
event you want to extend.

6  Begin playback.

7  Press Control (Windows) or Command (Mac-
intosh) and the track Mute button before the 
start of the mute event you want to extend.

To extend mute states on multiple tracks, 
set all the tracks to the same Automation 
mode.

Placing the cursor before the start of a mute event

To extend mute states on multiple tracks, 
press Alt+Control (Windows) or Op-
tion+Command (Macintosh) and the Mute 
button on the track.

Example: Place cursor here, before start of mute event



8  Before the end of the second mute event, re-
lease the key and the Mute button.

9  When you have finished the automation pass, 
click Stop.

Writing Automation to the Next 
Breakpoint

While performing an automation pass, 
Pro Tools lets you write current automation val-
ues from the current insertion point to the next 
(similar) automation breakpoint.

Like the Write to Start, End, and All commands, 
the standard Write to Next Breakpoint com-
mand does not operate when the Pro Tools 
transport is stopped. It only affects automation 
for those parameters that are currently write-en-
abled and currently writing automation data. 

If you extend past the subsequent on or off 
event, the entire event will be changed.

Stopping automation before the end of a mute event

Example of mute state extended

Example: Stop automation pass here, before end of mute event

mute off state extended (up to automation pass end)
Optionally, Write to Next Breakpoint can be 
configured to be applied automatically after a 
valid automation pass has been performed. 
See“Write to Next Breakpoint On Stop” on 
page 28

Write to Next Breakpoint remains enabled after 
a valid automation pass. Unlike Automation 
Write to Start, End, and All, it cannot be config-
ured to disable after an automation pass.

To write current automation values to the next 
breakpoint:

1  In the Automation Enable window, make sure 
that the automation type is write-enabled.

2  Click in a track at an insertion point.

3  Click Play to begin playback.

4  Make sure you are actively writing on the ap-
propriate track if you are in Latch or Touch 
mode.

5  When you are satisfied with the controller 
data you are writing, and you want to apply it, 
click Write to Next in the Automation Enable 
window. 

Write to Next Breakpoint has the same re-
quirements as Write to Start, End, and All 
commands. Refer to the Pro Tools Reference 
Guide for more information.

Write to Next Breakpoint button in the Automation 
Enable window

Write to Next Breakpoint button
C
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The current values of all controls being written 
at that point are written up to the next break-
point, and the transport will automatically stop.

Trim Mode for Write To Next Breakpoint

Using Trim mode, it is also possible to write trim 
delta values for track volume and send levels to 
the next written breakpoint.

To write current trim delta values to the next 
breakpoint:

1  In the Automation Enable window, make sure 
that the automation type (track volume or send 
level) is write-enabled.

2  In the Mix or Edit window, click the Auto-
mation Mode Selector and select Trim. The track 
volume and send level faders turn yellow.

3  Do one of the following:

• Click in a track at an insertion point.

– or –

• Drag with the Selector to select a portion of 
the track.

4  Click Play to begin playback. 

5  When you are satisfied with the controller 
data you are writing, and you want to apply it, 
click the Write to Next Breakpoint button in the 
Automation Enable window.

The relative changes to the track volume and 
send levels at that point are written to the corre-
sponding area of the track/selection.
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Write to Next Breakpoint On Stop

The Automation Enable window provides an 
option for automatic Write to Next Breakpoint 
on Stop.

Write to Next Breakpoint on Stop remains en-
abled after a valid automation pass. Unlike Auto 
Write on Stop Modes (Write to Start, End, and 
All On Stop), it cannot be configured to disable 
after an automation pass.

To configure Write to Next Breakpoint on Stop:

1  Open the Automation Enable window.

2  Click to enable Write to Next Breakpoint on 
Stop. 

When this option is enabled, automation writ-
ing will be performed automatically after a valid 
automation pass has been performed.

Write to Next Breakpoint on Stop button in the 
Automation Enable window

Write to Next Breakpoint On Stop button



Surround Enhancements

Combined Panning Mode Button

In the Surround Panner, the three Panning 
Mode buttons (X/Y Mode, Divergence Editing, 
and 3-Knob Mode) have been replaced with a 
single Panning Mode button.

The Panning Mode button cycles through all 
the Panning Modes (including the new Auto-
Glide mode).

To enable a Panning Mode:

1  Click the Panning Mode button in the Sur-
round Panner until the desired mode is dis-
played.

Panning Mode button (X/Y mode shown)

Panning Mode button
AutoGlide Mode

AutoGlide mode lets you quickly write Surround 
Panner automation by clicking new locations in 
the Surround Panner window, instead of manu-
ally moving the Surround Panner controls.

The time it takes to glide from point to point 
(from the Pan Location cursor to the new desti-
nation) is called the AutoGlide Time. This time 
is set in the Automation Preferences page and 
has a range of 1 mSec to 10000 mSec (10 sec-
onds).

To set the AutoGlide Time

1  Choose Setups > Preferences and click the 
Automation tab.

2  Set the AutoGlide Time.

To do an AutoGlide automation pass:

1  Click the Panning Mode button until the 
AutoGlide mode icon is displayed.

The Panning Mode button displays a slanted 
dotted line that ends with a filled in dot (repre-
senting a cursor) at its top right corner.

2  In the Mix or Edit window, click the Auto-
mation Mode Selector and select an Automation 
mode for the track you want to automate.

3  Press Play to begin playback.

When writing automation in AutoGlide 
mode, the Pan Location cursor cannot be 
dragged from its location.

Panner Mode button set to AutoGlide mode

AutoGlide mode icon
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4  Set a new destination for the cursor by doing 
one of the following:

• Click a speaker icon to glide to a speaker lo-
cation.

– or –

• Click in the pan window to glide to a spe-
cific location in the X/Y Grid.

The Pan Location cursor will begin to move to-
wards the new destination at the time it takes to 
travel the AutoGlide Time. When the new desti-
nation point is reached, a new breakpoint will 
be written at the new location.

5  Repeat the previous step if you want to write 
additional panning moves.

6  Stop the transport when finished.

Panning Mode button (AutoGlide mode shown)

AutoGlide mode

Pan 
Location
cursor

Speaker
icons
What’s New in Pro Tools TDM 6.9
Changes to Avid Compatibility

MXF Audio Import, Playback, and 
Export

In Pro Tools 6.9, Pro Tools supports import, 
playback, and export of MXF audio.

Publishing OMFI/MXF in Audio 
Export and Bounce to Disk Dialogs

In the following dialogs, the Publish as OMFI 
option has been removed:

• Export to OMF/AAF dialog

• Export Selected dialog

• Bounce to Disk dialog

Checking “Enforce Avid Compatibility auto-
matically exports all files as either OMFI or 
MXF.

New Localization Support

Full Korean and Simplified 
Chinese Localization

Pro Tools software and documentation are now 
available in Korean and Simplified Chinese, as 
well as Japanese.

See “Importing, Editing, and Exporting 
MXF Audio Files” on page 71 for more de-
tails.

For more information, see Chapter 4, “Sup-
port for Avid Video on Pro Tools|HD Sys-
tems with Pro Tools 6.9.”



Multilingual Application Support 
for Pro Tools TDM Systems
(Localized OS on Mac OS X Only)

An English and localized version of Pro Tools 
(such as Pro Tools Korean, simplified Chinese, 
or Japanese) can now be opened on a Digi-
design-qualified Macintosh that can run English 
and the localized language versions of 
Mac OS X.

To change to a different language version of 
Pro Tools:

1  Close Pro Tools if it is currently open.

2  Launch Apple System Preferences.

3  Double-click International (the “flag” icon).

4  Click the Language tab if the Language page is 
not the current page.

5  In the Languages column, click the language 
you want to change to, and drag the language to 
the top of the list.

6  Close the International window.

7  Do one of the following:

• If you are changing from a localized lan-
guage to English, launch Pro Tools.

– or –

• If you are changing from a localized lan-
guage to another localized language (or 
from English to a localized language), log 
out and log in from the Apple menu, then 
launch Pro Tools.

Only one language version of Pro Tools can 
be open at a time.

If you want your computer to boot up with 
the previous language, after working on a 
different language version, follow the above 
steps and change the International prefer-
ence back to the previous language.
Set Servo Lock Bit at Play 
(Tamura Support) Preference
The Machine Control Preferences page has a 
new option field, Set Servo Lock Bit at Play 
(Tamura Support).

Enable this option when using a Tamura syn-
chronizer to control Pro Tools in Remote mode 
to minimize lock-up times during recording.
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chapter 3

What’s New In Pro Tools 6.9 Control 
Surfaces
Support for D-Command
Pro Tools 6.9 provides support for D-Command, 
Digidesign’s new mid-sized control surface.

D-Command is a tactile worksurface for 
Pro Tools|HD systems that provides controls for 
almost every Pro Tools recording, editing and 
mixing task, and a versatile monitoring system 
based on the XMON interface.

Control Features

• Touch-sensitive, motorized 100mm faders

• Touch-sensitive, multi-purpose rotary con-
trols

• Dedicated controls for assignment and activa-
tion of inputs, outputs, inserts and sends

• Flexible display of pan, insert, send, plug-in 
and mic pre controls

• Dedicated EQ and dynamics plug-in control 
sections

• Dedicated controls for all channel strip func-
tions including recording and input monitor-
ing modes, mute, solo, and channel select

• Dedicated controls for automation mode, en-
able and safe status

For more information, refer to the 
D-Command Guide.
• Custom Faders Mode for flexible channel and 
parameter mapping

• Full transport and navigation controls, in-
cluding location commands and scrub/shut-
tle capability

Monitoring Features

• 6-channel control room monitoring system 
supports mono through 5.1 surround moni-
toring, with up to 5 possible input sources and 
3 selectable output paths.

• 2-channel headphone cue system with 4 sep-
arate outputs and selectable talkback feed.

• Built-in talkback microphone and external 
talkback mic Input.

• Standalone mode for monitoring without 
Pro Tools.

• External source metering.
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D-Control New Features and 
Enhancements
Pro Tools 6.9 includes many new features and 
enhancements for D-Control, in the following 
areas:

• Channel Strip Controls

• Automation

• Plug-In Controls

• Transport and Navigation

• Custom Fader Modes

• Soft Keys

• Display and Metering

• Monitoring

D-Control Channel Strip 
Features

Suppressing Value Display When 
Touching a Fader or Encoder

When you touch a channel fader or rotary en-
coder on D-Control, the corresponding display 
temporarily shows the value of the parameter 
you are adjusting.

In Pro Tools 6.9, you can suppress this tempo-
rary value display with the Touch Value Opera-
tion preference. 

To toggle value display on and off:

1  In the Soft Keys section, press the Operation 
switch repeatedly to display the page that in-
cludes Touch Value (“TchVal”).

2  Press the switch that corresponds to “TchVal” 
to toggle value display On and Off.
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Controlling Phantom Power in Mic 
Pre Mode

In Pro Tools 6.9, you can control mic pre phan-
tom power using either the top rotary encoder 
knob or the top B/M/P switch on a channel.

To toggle phantom power on or off:

1  Press the Mic Pre switch in the Channel Strip 
Mode controls section. The Encoder displays on 
each channel show the controls for the corre-
sponding Mic Pre channel.

2  Do one of the following:

• Turn the top rotary encoder knob.

• Press the top encoder B/M/P switch.

The B/M/P switch lights to indicate that phan-
tom power is on. 

Send Pre/Post Indication

In Pro Tools 6.9, when Send Assignments are 
shown in the D-Control channel strip encoder 
displays and you press the Switch Info switch, 
the display shows “PrePst” to indicate the func-
tion of the B/M/P switch, which is to toggle the 
Send between pre- and post-fader operation. 

D-Control channel strip rotary encoder

In previous versions of Pro Tools, the name 
of this function appeared as “Pre.”

auto

SEND A

Mute PreDyn Eq

B M PSelect

Encoder knob

Bypass/Mute/Pre
switch



Inline Console Mode

Many traditional consoles provide the ability to 
control an input channel and its corresponding 
monitor channel from a single channel strip.

In Pro Tools 6.9, you can simulate this inline 
console behavior with Inline mode, which lets 
you control an Auxiliary Input track and an Au-
dio track from a single channel strip on D-Con-
trol. 

An input signal (for example, from a Digidesign 
PRE) is brought into an Auxiliary Input track, 
and routed to an Audio track for recording and 
monitoring. Inline mode on D-Control is then 
used to control each of these elements from a 
single channel strip: the PRE and Auxiliary In-
put level controls are controlled with the chan-
nel strip encoders, and the record track levels are 
controlled with the channel strip fader.

To control an Auxiliary Input track and Audio track 
from a single D-Control channel strip:

1  Assign the output of a Digidesign PRE (op-
tional) or other audio source to an Auxiliary In-
put track.

2  Assign the output of the Auxiliary Input track 
to an Audio track.

3  On D-Control, press the Input switch in the 
Channel Strip Mode controls for the Audio 
channel.

4  On the Audio channel, press the encoder Se-
lect switch on the lowest row of encoders and 
turn the encoder knob to select the Auxiliary In-
put track.

5  Press Select to confirm the choice. 
The controls for the PRE and the Auxiliary Input 
appear on the Audio channel’s rotary encoders 
as follows, from top to bottom:

• Encoder 1 Knob/Switch: PRE Phantom 
Power

• Encoder 2 Knob/Switch: PRE Polarity

• Encoder 3 Knob/Switch: PRE Imped-
ance/Pad

• Encoder 4 Knob/Switch: PRE Source/Insert

• Encoder 5 Knob/Switch: PRE Gain/HPF 

• Encoder 6 Knob/Switch: Aux Gain/Aux 
Mute

6  (Optional) Hide the Auxiliary Input channels 
using the Show/Hide Soft Keys.

7  Adjust the PRE gain using Encoder 5.

8  Fine tune the input gain by adjusting the Aux-
iliary Input level using Encoder 6.

9  Press the Sends switch in the Channel Strip 
Mode controls and configure any cue mixes or 
effects sends for the channel.

10  Adjust the monitoring level with the Audio 
channel fader.

To view the hidden Auxiliary Input channel while in 
Inline mode:

■ Press Control (Windows) or Command (Mac-
intosh) and press the encoder Select switch on 
Encoder 6 of the Audio channel.

The Auxiliary Input channel is focused in the 
Focus Channel strip.
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Global Controls Affect Off-Bank 
Tracks

In Pro Tools 6.9, global controls on D-Control 
affect all tracks in a session, not just the ones 
currently displayed on the control surface. The 
controls affected by this change include the fol-
lowing:

Global Channel Strip Mode Controls

• Global Page Up and Page Down switches

• Global Dynamics and EQ switches

• Global Input switch

• Global Mic Pre switch

• Global Inserts switch

• Global Pan switch

• Global Sends switch

D-Control Global Channel Strip Mode controls

Page Dn Page Up

Mic Pre

Pan

Input

EQDyn

Sends

Inserts

Global Page Up
and Page Down

Global EQ

Global Mic Pre

Global Pan

Global Sends

Global Dynamics

Global Input

Global Inserts

switches

switch

switch

switch

switch

switch

switch

switch
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Channel Strip Mode Controls in Do To All Mode

• Dynamics and EQ switches

• Input switch

• Mic Pre switch

• Inserts switch

• Pan switch

• Sends switch

Channel Encoder Controls

• Encoder Select switch (to view all plug-ins or 
sends)

• Encoder B/M/P switch (to bypass all plug-ins 
or mute all sends)

Returning Controls to Their 
Default Settings

In Pro Tools 6.9, you can return controls such as 
channel volume, channel pan, send volume, 
send pan, and PRE gain to their default settings 
from D-Control in two ways: using the Alt (Win-
dows) or Option (Macintosh) switch on any 
Fader Module unit, or the Set to Default switch 
on the Main Unit.

D-Control channel strip rotary encoder

auto
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B M PSelect

Select Bypass/Mute/Pre
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To return a control to its default setting, do one of 
the following:

■ Hold Alt (Windows) or Option (Macintosh) 
and press the control’s switch or touch its fader 
or encoder.

– or –

■ Hold the Set to Default switch and press the 
control’s switch or touch its fader or encoder.

D-Control Automation 
Features

Automation Mode Controls

In Pro Tools 6.9, to change the automation 
mode of multiple channels from D-Control, the 
Do To Selected or Do To All functions must be 
used with the Automation Mode controls in the 
Channel Strip Master section.

To set the automation mode on multiple channels:

1  Press the Do To Selected switch.

2  Press the Select switches on the channels 
whose automation you want to set.

3  Press an Automation Mode switch (Write, 
Touch, Latch, Trim, Read, or Off). 

4  Press the flashing Do To Selected switch.

D-Control Automation Mode controls

Latch Off

Touch

Write Trim

Read

y

Auto Trim

Auto Read

Auto Off

Mode switch

Mode switch

switch

Mode switch
Auto Write

Mode switch

Auto Touch
Mode switch

Auto Latch
Mode switch
To set the automation mode on all channels:

1  Press the Do To All switch.

2  Press an Automation Mode switch (Write, 
Touch, Latch, Trim, Read, or Off). 

3  Press the flashing Do To All switch.

Automation Write To 
Start/End/All/Next Commands

In Pro Tools 6.9, the Write To Start, End, All, or 
Next commands can be invoked from the Soft 
Keys section of D-Control.

To use Automation Write To Start/End/All/Next:

1  Press the Action switch in the Soft Keys Auto-
mation section.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
press the Soft Key corresponding to Start, End, 
All or Next.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection.
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Automation Write On Stop Modes

In Pro Tools 6.9, when any of the Write On Stop 
modes (Write to Start, End, All, or Next On Stop) 
is enabled, the chosen action is performed auto-
matically after a valid automation pass, and the 
Write On Stop mode is then disabled. 

Write On Stop modes can also be configured to 
remain enabled after a valid automation pass.

On D-Control, Write on Stop modes can be con-
figured from the Auto Write section and from 
the Soft Keys section.

To configure Automation Write On Stop modes to 
disable after an automation pass:

1  Hold Start (Windows) or Control (Macintosh) 
and press the Start, End, or All switch in the 
Auto Write section. The switch flashes to indi-
cate that Write On Stop is enabled.

– or –

Press the Modes switch in the Soft Keys Automa-
tion section, and press the Soft Key correspond-
ing to Start, End, All or Next. The switch flashes 
to indicate that Write On Stop is enabled.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
stop playback.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection, and the Write on Stop mode 
is then disabled. The Start, End, All, or Next 
switch stops flashing to indicate that the Write 
on Stop mode is disabled.
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To configure Automation Write On Stop modes to 
remain enabled after an automation pass:

1  Hold Alt (Windows) or Option (Macintosh) 
and press the Start, End, or All switch in the 
Auto Write section. The switch lights to indicate 
that Write on Stop is enabled.

– or –

Press the Modes switch in the Soft Keys Automa-
tion section, then hold Alt (Windows) or Op-
tion (Macintosh) and press the Soft Key corre-
sponding to Start, End, All or Next. The switch 
lights to indicate that Write on Stop is enabled.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
stop playback.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection, and the Write on Stop mode 
stays enabled. The Start, End, All, or Next switch 
remains lit to indicate that Write on Stop mode 
is enabled.



Enabling Automation for All Plug-
In Parameters 

In Pro Tools 6.9, you can enable all parameters 
of a plug-in for automation at once from the EQ 
or Dynamics section, from a channel strip, or 
from Custom Fader Plug-In mode. 

To enable all parameters of a plug-in from the EQ or 
Dynamics section:

1  Focus the plug-in in the EQ or Dynamics sec-
tion.

2  Press the Auto switch in the EQ or Dynamics 
section. 

– or –

Press the Enable Parameter (“Enab Para”) switch 
in the Plug-In Automation section of the Chan-
nel Strip Master section. 

3  Hold Alt (Windows) or Option (Macintosh) 
and touch any encoder assigned to a plug-in pa-
rameter in the EQ or Dynamics section.

4  Press the lit Auto switch or the lit Enable Pa-
rameter switch to take D-Control out of the cor-
responding mode.
To enable all parameters of a plug-in for 
automation from a channel strip:

1  Focus the plug-in in the channel strip so its 
controls are visible on the channel strip encod-
ers.

– or –

Focus the plug-in you want to automate in the 
Custom Fader channel strips using Custom 
Fader Plug-In mode.

2  Press the Do To All switch in the Global Con-
trols section of the Channel Strip Master sec-
tion.

3  Hold Control+Alt+Start (Windows) or Con-
trol+Option+Command (Macintosh) and touch 
any channel strip encoder showing a plug-in 
control.

4  Press the lit Do To All switch to take D-Control 
out of Do To All mode.

To enable all parameters of a plug-in for 
automation from Custom Fader Plug-In mode:

1  Press and hold the Plug-In switch in the Cus-
tom Fader section to enter Custom Fader Ex-
panded Plug-In mode.

2  In the bottom row of Custom Fader channel 
encoders, press the Automation Enable (“Auto 
En”) switch.

3  Press the Do To All switch in the Global Con-
trols section of the Channel Strip Master sec-
tion.

4  Touch any assigned encoder or switch in the 
Custom Faders section.

5  Press the lit Do To All switch to take D-Control 
out of Do To All mode.

6  Press the Custom Fader Plug-In switch to exit 
Custom Fader Plug-In mode.
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D-Control Plug-In Features

Setting Plug-In List Display 
Options

In Pro Tools 6.9, you can choose how plug-in 
lists are organized in the Insert Selector and 
Plug-In Selector. Available choices include: Flat 
List (by Name); by Category; by Manufacturer; 
by Manufacturer and Category.

When selecting a plug-in on D-Control, these 
additional plug-in category sub-menus are dis-
played in yellow in the rotary encoder displays.

Closing AudioSuite Plug-In 
Windows

In Pro Tools 6.9, you can close all open Audio-
Suite plug-in windows along with any real-time 
plug-in windows from D-Control.

To close all open plug-in windows: 

■ Hold Alt (Windows) or Option (Macintosh) 
and press the Plug-In switch in the Window 
Management section.

Making Plug-ins Inactive or Active 
from Channel Strips

In Pro Tools 6.9, you can toggle the active/inac-
tive status of a plug-in directly from a channel 
strip without putting D-Control into Make Inac-
tive mode.

To toggle a plug-in active/inactive directly from a 
channel strip:

1  Press the Inserts switch on a channel strip to 
display the names of the plug-ins on that chan-
nel’s encoders.
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2  Hold Control+Start (Windows) or Con-
trol+Command (Macintosh) and press the en-
coder Select switch for the plug-in.

Changing Plug-In Presets from 
Channel Strips

In Pro Tools 6.9, you can activate next or previ-
ous settings in the Plug-In Librarian menu di-
rectly from any channel strip on D-Control. 
These commands mirror the Next and Previous 
Setting buttons in the plug-in header.

To enable the next or previous plug-in setting from 
a channel strip:

1  Focus the plug-in in a channel strip so its con-
trols are visible on the channel strip encoders.

2  Hold Control (Windows) or Command (Mac-
intosh) and press the Page Up (Next) or Page 
Down (Previous) switch in that channel strip’s 
Channel Strip Mode controls.

Copying and Pasting Plug-In 
Settings

In Pro Tools 6.9, you can copy plug-in settings 
from a plug-in and paste them in another in-
stance of the same plug-in directly from a chan-
nel strip on D-Control, from either the top-level 
view or the focused view of the plug-in.

To copy and paste plug-in settings from the top 
level plug-in view:

1  On channel strips where you want to copy 
and paste the plug-in settings, press the Inserts 
switches to display the names of the plug-ins on 
the channel encoders. 

2  Copy the settings of a plug-in by holding 
Shift+Control (Windows) or Shift+Command 
(Macintosh) and pressing the Select switch un-
der the name of the plug-in. 



3  Paste the settings into another instance of the 
same plug-in by holding Shift+Control (Win-
dows) or Shift+Command (Macintosh) and 
pressing the B/M/P switch under the name of 
that plug-in.

To copy and paste settings from the focused plug-
in view:

1  On channel strips where you want to copy 
and paste the plug-in settings, focus the plug-ins 
on the channels so their controls are visible on 
the channel strip encoders. 

2  Copy the settings of a plug-in by holding 
Shift+Control (Windows) or Shift+Command 
(Macintosh) and pressing the Select switch un-
der the bottom row of encoders for the plug-in. 

3  Paste the settings into another instance of the 
same plug-in by holding Shift+Control (Win-
dows) or Shift+Command (Macintosh) and 
pressing the B/M/P switch under the bottom 
row of encoders for that plug-in.

Saving Dynamics and EQ Plug-In 
Settings

In Pro Tools 6.9, you can confirm or cancel the 
Save Settings dialog from the Dynamics or EQ 
sections of D-Control.

You can use the Do To All and Do To 
Selected Global Controls to copy and 
paste settings to all plug-ins at the 
same insert position on all or all 
selected tracks.
To save plug-in settings from D-Control:

1  Adjust the settings of a plug-in from the Dy-
namics or EQ section of D-Control. 

2  Press the Save As switch in that section. The 
switch flashes to indicate the Save Settings dia-
log is open on-screen.

3  Enter a name for the setting.

4  Do one of the following:

• Press the flashing Save As switch to save the 
setting.

– or –

• Press the Escape switch (in the Channel 
Strip Master Control section or the Soft Key 
section) to cancel the save operation. 

Storing Custom Fader Plug-In 
Maps

In Pro Tools 6.9, Custom Fader Plug-In Maps are 
no longer stored in the Pro Tools session file. In-
stead, plug-in mapping information is stored in 
a separate Plug-In Map (“.pim”) file. This lets 
you retain plug-in maps across multiple ses-
sions, and lets you transfer plug-in maps be-
tween systems.

To export plug-in maps:

1  In Custom Fader Plug-In Map mode, create a 
map for each plug-in you want to use. 

2  In the Soft Keys section, press the Operation 
switch repeatedly to display the page that in-
cludes Export Plug-In Maps (“Export PIMaps”).

3  Press the Soft Key that corresponds to “Export 
PIMaps.”

4  Enter a name for the Plug-In Map file, choose 
a location, and press the Soft Key that corre-
sponds to Enter.
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To import plug-in maps:

1  In the Soft Keys section, press the Operation 
switch repeatedly to display the page that in-
cludes Import Plug-In Maps (“Import PIMaps”).

2  Press the Soft Key that corresponds to “Import 
PIMaps.”

3  Choose a Plug-In Map (.pim) file and click 
Open.

Clearing Custom Fader Plug-In 
Maps

In Pro Tools 6.9, you can clear the Custom Fader 
Plug-In maps for a plug-in with a single com-
mand.

To clear maps for a plug-in currently displayed in 
Custom Fader plug-in mode:

1  In Custom Faders Plug-In Map mode, display 
the plug-in whose map you want to clear.

2  Press the Set to Default switch. 

3  Press the Do To All switch.

4  Press the Select switch on any of the Custom 
Fader channel strips. 

5  Press the flashing Do To All and Set To Default 
switches. 
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D-Control Transport and 
Navigation Features

Focusing Transport Control On 
Timeline or Edit Selections

In Pro Tools 6.9, when the Timeline and Edit se-
lections in the Edit window are unlinked, you 
can set the D-Control Transport to control play-
back of either the Timeline selection or the Edit 
selection. (

To focus the D-Control Transport on the Timeline 
selection:

■ Press the Edit/Timeline Selection switch in the 
Miscellaneous Controls section so that the 
Timeline LED is lit.

To focus the D-Control Transport on the Edit 
selection:

■ Press the Edit/Timeline Selection switch in the 
Miscellaneous Controls section so that the Edit 
LED is lit.

In previous versions of Pro Tools, the con-
trol surface transport always controlled the 
Timeline selection.

D-Control Edit/Timeline switch in the Misc Controls

Edit T-Line

Start

End

Length

Loc

Edit/Timeline
Selection
switch and
indicators



Latching Behavior for Fast 
Forward Switch and Rewind 
Switches

In Pro Tools 6.9, you can set Fast Forward or Re-
wind to follow latched behavior from the 
D-Control Transport section. 

To set Fast Forward to latch:

■ Hold the Fast Forward switch and momen-
tarily press the Rewind switch. 

To set Rewind to latch:

■ Hold the Rewind switch and momentarily 
press the Fast Forward switch.

Nudging the Track Focus

In Pro Tools 6.9, you can nudge the display of 
the Focus Channel Strip forward or backward in 
1-channel or 8-channel increments. 

To nudge the track focus forward or backward by 
one channel:

■ With a track focused in the Focus Channel 
Strip, hold Control (Windows) or Command 
(Macintosh) and press the left or right Nudge 1 
switch in the Bank/Nudge section.

D-Control Nudge switches

Nudge 8

Nudge 1

Bank

Home

Bank/Nudge

Nudge by 1 Track

Nudge by 8 Tracks

Left and Right

Left and Right
To nudge the track focus forward or backward by 
eight channels:

■ With a track focused in the Focus Channel 
Strip, hold Control (Windows) or Command 
(Macintosh) and press the left or right Nudge 8 
switch in the Bank/Nudge section.

Selecting Multiple Tracks

In Pro Tools 6.9, you can quickly select a range 
of track (or contiguous tracks) directly from the 
control surface. In addition, the shortcuts for se-
lecting and de-selecting non-contiguous tracks 
have changed.

To select a range of tracks:

1  Press the Select switch on the first channel in 
the range you want to select.

2  Hold Shift and press the Select switch on the 
last channel in the range you want to select. 

All tracks between the first channel and last 
channel (inclusive) are selected.

To select or deselect multiple, non-contiguous 
tracks:

■ Hold Control (Windows) or Command (Mac-
intosh) and press the Select switches on multi-
ple channels.
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Changing Playback Location with 
Locate Switches

In Pro Tools 6.9, the following commands are 
available from the Transport section of D-Con-
trol.

Back Moves the playback location backward by 
the Back/Forward Amount. 

Back and Play Moves the current playback loca-
tion backward by the Back/Forward Amount 
and automatically begins playback.

Forward Moves the playback location forward by 
the Back/Forward Amount.

Forward and Play Moves the current playback lo-
cation forward by the Back/Forward amount 
and automatically begins playback.

To move the playback location backward:

■ Press the Back switch in the Transport section.

To move the playback location backward and 
begin playback:

■ Press the Back and Play switch in the Trans-
port section.

To move the playback location forward:

■ Hold Alt (Windows) or Option (Macintosh) 
and press the Back switch in the Transport sec-
tion.

To move the playback location forward and begin 
playback:

■ Hold Alt (Windows) or Option (Macintosh) 
and press the Back and Play switch in the Trans-
port section.
What’s New in Pro Tools TDM 6.9
D-Control Custom Fader 
Features

Dual Custom Fader Banks

In Pro Tools 6.9, D-Control has available two in-
dependent banks of Custom Faders, controlled 
by the Custom Fader Control sections on the 
left and right sides of the Main Unit. 

Each of the Custom Fader banks can be con-
trolled from the Bank Select Matrix, one at a 
time. The currently targeted Custom Fader bank 
is indicated by yellow text in the Custom Fader 
display.

Custom Groups In Custom Groups mode, each 
of the two banks of Custom Faders can control 
any of the 48 available Custom Groups.

Mix/Edit Groups In Mix/Edit Groups mode, each 
of the two banks of Custom Faders can control 
any of the 26 Mix/Edit Groups.

Tracks Mode In Tracks Mode, each of the two 
banks of Custom Faders can control any of the 
track types (Master Faders, Audio Tracks, Auxil-
iary Inputs, MIDI Tracks, or Hidden Tracks). 

Plug-In Mode In Plug-In mode, each of the two 
banks of Custom Faders can control separate 
plug-ins.

In previous versions of Pro Tools, the two 
Custom Fader Control sections provided 
redundant control of a single Custom Fader 
bank.



Configuring Custom Fader Banks

In Pro Tools 6.9, you can independently set the 
location of each bank of Custom Faders, and 
decrement or increment the number of Custom 
Fader channels in each bank.

To configure the distribution of Custom Faders on 
the control surface:

■ Press the Operation switch in the Soft Keys 
section. The following Soft Keys control the ar-
rangement of the Custom Fader banks:

Left Custom Fader Justification Determines 
whether the Custom Faders controlled by the 
left Custom Faders section are placed at the left, 
left center, right center, or right of the Main 
Unit.

Right Custom Fader Justification Determines 
whether the Custom Faders controlled by the 
right Custom Faders section are placed at the 
left, left center, right center, or right of the Main 
Unit.

Left Maximum Custom Fader Bank Size Deter-
mines the number of channels to be used when 
displaying channels in the Left Custom Fader 
Bank. Options are multiples of 8 channels, from 
zero (no Left Custom Fader Bank) up to the max-
imum number of channels on the system.

Right Maximum Custom Fader Bank Size Deter-
mines the number of channels to be used when 
displaying channels in the Right Custom Fader 
Bank. Options are multiples of 8 channels, from 
zero (no Right Custom Fader Bank) up to the 
maximum number of channels on the system.
To set the maximum Custom Fader bank size:

1  Press the Operation switch in the Soft keys 
section.

2  Do one of the following:

• To increment the number of channel strips, 
press the Soft Key that corresponds to 
“LMax CF” or “RMax CF.”

• To decrement the number of channel 
strips, hold Shift and press the Soft Key that 
corresponds to “LMax CF” or “RMax CF.”

Each of the Max CF values increments or decre-
ments in multiples of 8 channels.

Controlling Custom Fader Banks

The Bank Select Matrix on D-Control is used in 
Custom Fader mode to create and select Custom 
Groups and Mix/Edit Groups. In Pro Tools 6.9, 
it can also be used to select tracks by type or to 
view plug-in control pages.

To target a Custom Fader bank in the Bank Select 
Matrix:

■ Press any Custom Fader mode switch in the 
Custom Fader Control section that corresponds 
to the bank you want to control.

Mix/Edit Groups

When viewing Mix/Edit Groups in Custom Fad-
ers mode, you can create, display and edit 
Pro Tools Mix or Mix/Edit Groups from the 
Bank Select Matrix. 

Mix or Mix/Edit groups are accessible in the 
Bank Select Matrix in three banks of 12 (All–k, 
l–w, and x–z.). This functionality is the same as 
in previous versions of Pro Tools.

In Pro Tools 6.9, Mix/Edit Group names can also 
be shown in the Soft Keys by pressing the Bank 
Select switch in the Soft Keys section.
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Custom Groups

When viewing Custom Groups in Custom Fad-
ers mode, you can create, display and edit Cus-
tom Groups from the Bank Select Matrix. In 
Pro Tools 6.9, the number of available Custom 
Groups on D-Control increases to 48. 

Custom Groups are accessible in the Bank Select 
Matrix in four banks of 12 (1–12, 13–24, 25–36, 
and 37–48). You can cycle though banks of Cus-
tom Groups by holding Shift and pressing the 
Bank/Cycle switch in the Custom Faders sec-
tion.

In Pro Tools 6.9, Custom Groups can also be 
shown in the Soft Keys by pressing the Bank Se-
lect switch in the Soft Keys section.

Track Types

In Pro Tools 6.9, the D-Control Custom Faders 
switch formerly named “Master” changes to 
“Tracks.” You can display tracks on the Custom 
Faders according to their track type by pressing 
the Tracks switch. You can then select the track 
type from the Bank Select Matrix, as follows:

• Bank Select 1= Master Faders

• Bank Select 2 = Audio Tracks

• Bank Select 3 = Auxiliary Inputs

• Bank Select 4 = MIDI Tracks

• Bank Select 5 = Hidden Tracks

The name of the track type is shown in the Cus-
tom Faders display.

If the number of tracks exceeds the number of 
Custom Fader channel strips, the tracks can be 
banked with the Bank/Cycle switch in the Cus-
tom Faders section.

The track types can also be displayed in the Soft 
Keys section by pressing the Bank Select switch 
in the Soft Keys section.
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Plug-In Pages

When viewing Plug-In parameters on Custom 
Faders, you can select pages of parameters from 
the Bank Select Matrix. 

If a plug-in has more than 12 pages, you can cy-
cle though banks of pages by holding Shift and 
pressing the Bank/Cycle switch in the Custom 
Faders section.

The plug-in pages can also be displayed in the 
Soft Keys section by pressing the Bank Select 
switch in the Soft Keys section. 

Arranging Channels in Custom 
Groups

You can insert new Custom Group channels at 
any location in the Custom Fader channel dis-
play. By default, new Custom Group channels 
are added to the end of the Custom Faders. 

To add new channels to a Custom Group:

1  Press the Custom switch in the Custom Faders 
section to enter Custom Groups mode.

2  Press the Bank Select switch (1–12) to recall 
the Custom Group you want to edit.

3  Press the Edit switch in the Bank Select sec-
tion. The Edit switch flashes to indicate Custom 
Groups Edit mode. 

4  On a currently assigned Custom Fader chan-
nel strip, press the Select switch so that it is lit.

5  Press the Select switch on each Normal chan-
nel you want to add to the Custom Group. 

The new channels are added the Custom Group, 
to the left of the selected Custom Fader channel 
strip.



To remove channels from a Custom Group:

■ While editing the Custom Group, hold Con-
trol+Start (Windows) or Control+Command 
(Macintosh) and press the Select switch on the 
Custom Fader channel you want to remove.

– or –

■ Hold the Set To Default switch and press the 
Select switch on a track you want to remove.

Display of Hidden Tracks in 
Custom Faders

You can set D-Control to show hidden tracks in 
the Custom Fader views. You can then mix 
those hidden tracks, but you cannot select or 
record-enable them. Hidden track names are 
displayed in yellow in the Custom Faders.

To make hidden tracks visible in Custom Fader 
views:

1  In the Soft Keys section, press the Operation 
switch repeatedly to display the page that in-
cludes Custom Fader Tracks (“CFTrks”). 

2  Press the Soft Key that corresponds to 
“CFTrks” to toggle the setting between Show 
Hidden Tracks (“ShwHdn”) and Hide Hidden 
Tracks (“HidHdn”). 
Displaying A Plug-In in Custom 
Fader Plug-In Mode

In Pro Tools 6.9, you can enter Custom Fader 
Plug-In mode and focus a plug-in on the Cus-
tom Fader channels directly from the top level 
plug-in view.

To display a plug-in in Custom Fader Plug-In mode:

■ In top level plug-in view, hold Control (Win-
dows) or Command (Macintosh) and press the 
Encoder Select switch for the plug-in you want 
to display. 
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D-Control Soft Keys Section Features
In Pro Tools 6.9, the Soft Keys section has been changed to consolidate existing switch functions and 
add switches for new Automation functions.
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D-Control Soft Keys section showing new keys
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Window
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Edit

Soft Keys
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switch

Show/Hide
switch
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switch
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switch
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switch

Soft Key switches
and

displays
Select/MIDI Soft Key Functions

Bank Select Switch

The Bank Select switch (“Bank Sel”) sets the Soft 
Keys to mirror the selection in the Bank Select 
Matrix. When Bank Select is enabled, the Soft 
Keys show the names of the Mix/Edit Groups, 
Custom Groups, track types, or plug-in page 
numbers being controlled by the Bank Select 
Matrix.
Because the Bank Select Matrix has 12 switches, 
the Soft Keys display each bank of twelve in two 
pages of 6. The Soft Key display is paged by re-
peatedly pressing the Bank Select switch in the 
Soft Keys section.

To page through the currently displayed bank in 
the Soft Keys:

■ Press the Bank Select switch (“Bank Sel”) re-
peatedly to page through the current bank.
Memory Location Switch

The Memory Location switch (“Mem Loc”) sets 
the Soft Keys to display the names of Memory 
Locations in pages of 6. The Soft Key display is 
paged by repeatedly pressing the Memory Loca-
tion switch in the Soft Keys section.



MIDI Switch

The MIDI switch sets the Soft Keys to display the 
following MIDI commands, in two pages of 6: 

• Wait for Note

• Countoff

• Merge Record

• Transpose

• Change Velocity

• Click On/Off

• Change Tempo

• Change Meter

• Split Notes

• Select Notes

• Quantize

• Input Quantize

Console Prefs Soft Key Functions

User Switch

The User switch lets you assemble a custom set 
of up to 12 Soft Key operations (6 on each of two 
pages), providing quick access to frequently 
used commands or modes. You can add opera-
tions to either of the two available pages.
To add a Soft Key operation to the User Soft Key 
set:

1  In the Soft Keys section, press the User switch 
repeatedly to display the page (Page 1 or Page 2) 
where you want to add the operation.

2  Press another Soft Key switch to enter the Soft 
Key mode containing the operation you want to 
add. 

3  Hold Control (Windows) or Command (Mac-
intosh) and press the Soft Key for the operation.

The operation is appended to the list of User 
Soft Key operations on the chosen User page.

To remove a Soft Key operation from the User set:

1  In the Soft Keys section, press the User switch 
repeatedly to display the operation you want to 
remove.

2  Hold Control (Windows) or Command (Mac-
intosh) and press the Soft Key for the User oper-
ation. 

Meter Switch

The Meter switch sets the Soft Keys to display 
the D-Control metering preferences, in pages of 
six. The Soft Key display is paged by repeatedly 
pressing the Meter Prefs switch in the Soft Keys 
section. 

In Pro Tools 6.9, a new Meter preference is avail-
able. See “Gain Reduction Priority Meter Prefer-
ence” on page 53.
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Operation Switch

The Operation switch sets the Soft Keys to dis-
play the D-Control preferences for Custom 
Fader arrangement, fader and rotary encoder be-
havior, channel strip display, and on-screen in-
teraction. 

In Pro Tools 6.9, the following preferences have 
been added:

• Import Plug-In Maps

• Export Plug-In Maps

• Touch Value On/Off

• Custom Faders Show/Hide Hidden Tracks

• Broadcast On/Off

Automation Soft Key Functions

AutoMatch Switch

In Pro Tools 6.9, the AutoMatch feature can be 
applied to Write and Latch automation modes 
as well as Touch automation mode.

During playback, the AutoMatch switch is used 
to stop writing of automation on Write-enabled 
or Latch-enabled tracks and return automation 
to previously written levels by ramping up or 
down according to the AutoMatch time.

To set the AutoMatch time: 

1  Press the Prefs switch in the Soft Keys Automa-
tion section. 

2  Press the Soft Key that corresponds to Match 
Time. 

3  Turn the jog wheel to adjust the Match Time. 

4  Press the lit Soft Key to exit.

AutoMatch time can be changed during 
playback.
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To end an automation pass on a single Write- or 
Latch-enabled track with AutoMatch:

■ During playback, at the point where you want 
to stop writing automation on a track, press the 
Automation Mode switch (“Auto”) on the chan-
nel.

The track stops writing automation and ramps 
back to the previous automation level. The 
length of the automation ramp is determined by 
the AutoMatch Time preference.

To end an automation pass on all tracks with 
AutoMatch:

■ During playback, at the point where you want 
to stop writing automation, press the Auto-
Match switch. 

All tracks in Write or Latch mode stop writing 
automation and ramp back to previous automa-
tion levels. The length of the automation ramp 
is determined by the AutoMatch Time prefer-
ence.

Snap Back Function

During playback, the Snap Back function is used 
to stop writing of automation on Write-enabled 
or Latch-enabled tracks and return automation 
instantly to previously written levels, ignoring 
any AutoMatch or AutoGlide settings. 

To end an automation pass and return instantly to 
previously written automation levels:

1  Press the Action switch.

2  During playback, at the point where you want 
to stop writing automation, press the Soft Key 
corresponding to Snap Back.



Join Switch

The Join switch is used in Latch mode to manu-
ally resume writing of automation after the 
transport is stopped and started again during an 
automation pass. 

The Join function can be used while working 
continuously in Latch mode, or after the auto-
mation mode changes to Latch mode from 
Write mode or Touch mode.

To manually resume writing automation in Latch 
mode:

1  After writing an automation pass, stop the 
transport. The Join switch flashes when the au-
tomation for one or more controls can be re-
sumed in Latch mode.

2  Use the Rewind button or the Selector tool to 
move the cursor back so that it is just before the 
stop location.

3  Resume playback.

4  At the point where you want to start writing 
automation, press the flashing Join switch.

Automation recording continues for all controls 
in Latch mode.
AutoJoin Switch

The AutoJoin switch is used in Latch mode to 
automatically resume writing of automation af-
ter the transport is stopped and started again 
during an automation pass.

The AutoJoin function can be used while work-
ing continuously in Latch mode, or after the au-
tomation mode changes to Latch mode from 
Write mode or Touch mode.

To automatically resume writing automation in 
Latch mode:

1  After writing an automation pass, stop the 
transport. The Join switch flashes when the au-
tomation for one or more controls can be re-
sumed in Latch mode.

2  Press the AutoJoin switch so that it is lit. A red 
line, the AutoJoin Indicator, appears in the Edit 
window to show the stop location. 

3  Use the Rewind switch or the Selector tool to 
move the cursor back so that it is just before the 
stop location.

4  Resume playback.

At the AutoJoin Indicator, automation record-
ing resumes automatically for all controls in 
Latch mode.
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Action Switch

The Action switch sets the Soft Keys to display 
the following commands:

Write to Start Performs a manual Write to Start 
command (mirrors the corresponding button in 
the Automation Enable window).

Write to All Performs a manual Write to All com-
mand (mirrors the corresponding button in the 
Automation Enable window).

Write to End Performs a manual Write to End 
command (mirrors the corresponding button in 
the Automation Enable window).

Write to Next Performs a manual Write to Next 
command (mirrors the corresponding button in 
the Automation Enable window).

Snap Back During playback, stops writing of au-
tomation in Write or Latch mode and returns 
automation instantly to previously written lev-
els, without applying any AutoMatch or Au-
toGlide ramping.

Modes Switch

The Modes switch sets the Soft Keys to display 
the following modes:

Auto Write to Start Enables Auto Write to Start 
On Stop mode (mirrors the corresponding but-
ton in the Automation Enable window).

Auto Write to All Enables Auto Write to All On 
Stop mode (mirrors the corresponding button in 
the Automation Enable window).

Auto Write to End Enables Auto Write to End On 
Stop mode (mirrors the corresponding button in 
the Automation Enable window).

Auto Write to Next Enables Auto Write to Next 
On Stop mode (mirrors the corresponding but-
ton in the Automation Enable window).
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Prefs Switch

The Prefs switch sets the Soft Keys to display the 
following preferences:

Match Time Determines the AutoMatch Time, 
or the amount of time it takes for automation 
values to return to the previously written value 
after an automation pass stops.

Glide Time Determines the AutoGlide Time, or 
the amount of time it takes for surround pan 
values to move between two points in an auto-
mation pass performed with the optional 
D-Control surround panner. 

Show/Hide Switch

The Show/Hide Switch in the Soft Keys section 
displays track type choices in the Soft Key dis-
play. 

The Soft Key display is paged by repeatedly 
pressing the Show/Hide switch. 

The following Show/Hide categories are avail-
able in the Soft Key display:

• Show/Hide All Tracks

• Show/Hide Only Selected Tracks

• Show/Hide Inactive Tracks

• Show/Hide Audio Tracks

• Show/Hide Aux Tracks

• Show/Hide MIDI Tracks

You can select multiple Show/Hide categories by 
holding Shift while pressing the corresponding 
Soft Key. 



Exiting from Soft Key Modes

Instead of cycling through all pages of a Soft Key 
mode, you can exit and return to the default 
Soft Key display by holding Control (Windows) 
or Command (Macintosh) and pressing the cur-
rently lit Soft Key mode switch.

Closing On-Screen Dialog Boxes

When Pro Tools has a dialog on-screen, the Soft 
Key section temporarily displays “Escape” 
(when applicable) and “Enter,” letting you can-
cel or confirm the dialog from the control sur-
face.

D-Control Display and 
Metering Features

Gain Reduction Priority Meter 
Preference

When encoder LED rings and channel meters 
are set to display dynamics plug-in gain reduc-
tion, you can set which function has priority 
when multi-function Compressor/Gate plug-ins 
are used.

To set the gain reduction metering priority:

1  In the Soft Keys section, press the Meter Prefs 
switch repeatedly to display the page that in-
cludes Gain Reduction Priority (“GRPrio”).

2  Press the Soft Key that corresponds to
“GRPrio” to toggle the setting between Com-
pressor/Limiter (“CompLm”) and Ex-
pander/Gate (“ExpGat”). 

Metering priority is assigned to the correspond-
ing function.
Full Display of Names In Assign 
Mode

When assigning Input, Outputs, Inserts, or 
Sends, four adjacent encoder displays are used 
to spell out the name of the element being as-
signed. In Assign mode, when an encoder is 
touched or a Select switch is pressed, the dis-
plays temporarily show the full name of the in-
put, output, insert, plug-in category, or plug-in. 

Closing Workspace Browser 
Windows

You can close all open Workspace Browser win-
dows at once from D-Control.

To close all Workspace Browser windows: 

■ Hold Alt (Windows) or Option (Macintosh) 
and press the Workspace switch in the Window 
Management section.

(Normal) Flop Mode Update

In Pro Tools 6.9, Flop mode can be used to trans-
fer or “flop” controls between any two rows of 
rotary encoders. 

To flop controls between rows of encoders:

1  Hold the Start (Windows) or Control (Macin-
tosh) and repeatedly press the Flip switch on the 
row of encoders where you want transfer the 
controls.

2  Continue to hold Start (Windows) or Control 
(Macintosh) and repeatedly press the same Flip 
switch to cycle through the encoder rows. The 
Flip switches on each row light to indicate 
which controls are being transferred. 

In previous versions of Pro Tools, Flop mode 
transferred controls to the bottom row of en-
coders only.
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3  When you reach the row you want to transfer, 
release Start (Windows) or Control (Macintosh). 
The flopped controls are indicated by yellow 
text in the encoder displays.

To return flopped controls to their original 
positions:

■ Press either of the lit Flip switches.

D-Control Monitoring Features

Solo Mode Controls

In Pro Tools 6.9, the Solo function has three 
available modes: Solo in Place (SIP), After-Fader 
Listen (AFL) and Pre-Fader Listen (PFL). 

◆ SIP mode mutes all unsoloed tracks, causing 
the soloed tracks to be auditioned alone in the 
main mix. The XMON Control Room Input 
source remains unchanged, so you can monitor 
the soloed channels in the Main control room 
monitors. 

◆ AFL and PFL modes send signal to a separate 
output path with independently adjustable lev-
els for each mode. The XMON Control Room In-
put source is automatically changed to monitor 
the AFL/PFL input. This lets you monitor the so-
loed channels in the Main control room moni-
tors or in a dedicated solo monitoring system.

AFL and PFL Solo modes require the use of 
the Surround Mixer plug-in. 
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To select the Solo mode:

■ Press the SIP, AFL, or PFL switch in the D-Con-
trol Monitor section to select the corresponding 
Solo mode.

Setting AFL and PFL Levels

Levels can be set separately for AFL and PFL 
modes from the D-Control Monitor section.

To set the AFL or PFL level:

1  Press the AFL or PFL switch in the D-Control 
Monitor section. 

2  Turn the AFL/PFL rotary encoder. The AFL/PFL 
level is shown in the Monitor displays.

To set the AFL or PFL level to its default setting:

1  Press the AFL or PFL switch in the D-Control 
Monitor section. 

2  Hold Alt (Windows) or Option (Macintosh) 
and touch the AFL/PFL rotary encoder. 

Solo Mode controls in the D-Control Monitor section

AFL or PFL levels can be adjusted even if no 
channels are currently soloed.

AFL Ltch

PFL Moment

SIP X-OR

AFL/PFL

AFL/PFL
Level control

AFL switch

PFL switch

SIP switch

Latch switch

Momentary switch

X-OR switch



Broadcast Mode for AFL and PFL 
Monitoring

You can put the D-Control monitoring system 
in Broadcast Mode, which prevents AFL and PFL 
solo modes from changing the XMON Control 
Room Input source. 

This lets you monitor the AFL/PFL input on a 
separate set of speakers or headphones, leaving 
the main monitor mix undisturbed, for pur-
poses of live recording or broadcast feeds. 

To put the XMON monitoring system in Broadcast 
mode:

1  Press the Operation switch in the Soft Key sec-
tion.

2  Press the Soft Key that corresponds to “Broad-
cast” to set the option to “On.”

While in Broadcast mode, any channels soloed 
while in AFL or PFL are sent to the dedicated 
monitor path. Any channels soloed in SIP mode 
will still cause all other tracks to be muted. 

Solo Latch Options

In Pro Tools 6.9, three solo latch options can be 
selected directly from the D-Control Monitor 
section. These latching options apply to all 
three Solo modes (SIP, AFL and PFL). 

Latch When this option is selected, pressing 
subsequent channel Solo switches adds the 
channels to the Solo output.

X-OR When this option is selected, pressing a 
channel Solo switch unsolos any other chan-
nels.

To solo more than one track at the same 
time in X-OR mode, press and hold a single 
Solo switch, then press additional Solo 
switches to latch them on.
Momentary When this option is selected, you 
can temporarily solo any number of channels by 
holding a single channel Solo switch and press-
ing any additional channel Solo switches. When 
you release the held Solo switch, all solos are 
cleared.

ProControl Features
Pro Tools 6.9 includes the following new fea-
tures and enhancements for ProControl:

Changing Playback Location

In Pro Tools 6.9, the following commands are 
available from ProControl:

Back Moves the playback location backward by 
the Back/Forward Amount. 

Back and Play Moves the current playback loca-
tion backward by the Back/Forward Amount 
and automatically begins playback.

Forward Moves the playback location forward by 
the Back/Forward Amount.

Forward and Play Moves the current playback lo-
cation forward by the Back/Forward amount 
and automatically begins playback.

To move the playback location backward:

■ Hold Control (Windows) or Command (Mac-
intosh) and press the Rewind switch in the 
ProControl Transport.

To move the playback location backward and 
begin playback:

■ Hold Control+Alt (Windows) or Com-
mand+Option (Macintosh) and press the Re-
wind switch in the ProControl Transport.
Chapter 3: What’s New In Pro Tools 6.9 Control Surfaces 55



56
To move the playback location forward:

■ Hold Control (Windows) or Command (Mac-
intosh) and press the Fast Forward switch in the 
ProControl Transport.

To move the playback location forward and begin 
playback:

■ Hold Control+Alt (Windows) or Com-
mand+Option (Macintosh) and press the Fast 
Forward switch in the ProControl Transport.

Automation Commands

In Pro Tools 6.9, the following commands are 
available from ProControl:

AutoMatch Function

During playback, you can stop writing of auto-
mation on Write-enabled or Latch-enabled 
tracks and return automation to previously writ-
ten levels by ramping up or down according to 
the AutoMatch time.

To end an automation pass on a single Write- or 
Latch-enabled track with AutoMatch:

■ During playback, at the point where you want 
to stop writing automation on a track, press the 
Automation switch (“Auto”) on the channel.

The track stops writing automation and ramps 
back to the previous automation level. The 
length of the automation ramp is determined by 
the AutoMatch Time preference.
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To end an automation pass on all tracks with 
AutoMatch:

■ During playback, at the point where you want 
to stop writing automation, hold Alt (Windows) 
or Option (Macintosh) and press the Automa-
tion switch (“Auto”) on a Write- or Latch-en-
abled channel.

All tracks in Write or Latch mode stop writing 
automation and ramp back to previous automa-
tion levels. The length of the automation ramp 
is determined by the AutoMatch Time prefer-
ence.

Snap Back Function

During playback, you can stop writing of auto-
mation on Write-enabled or Latch-enabled 
tracks and return automation instantly to previ-
ously written levels, ignoring any AutoMatch or 
AutoGlide settings.

To end an automation pass on a single Write- or 
Latch-enabled track with Snap Back:

■ During playback, at the point where you want 
to stop writing automation on a track, hold 
Control (Windows) or Command (Macintosh) 
and press the Automation switch (“Auto”) on 
the channel.

To end an automation pass on all tracks with Snap 
Back:

■ During playback, at the point where you want 
to stop writing automation, hold Control+Alt 
(Windows) or Command+Option (Macintosh) 
and press the Automation switch (“Auto”) on a 
Write- or Latch-enabled channel.



Join Function

The Join function is used in Latch mode to man-
ually resume writing of automation after the 
transport is stopped and started again during an 
automation pass. 

The Join function can be used while working 
continuously in Latch mode, or after the auto-
mation mode changes to Latch mode from 
Write mode or Touch mode.

To manually resume writing automation in Latch 
mode:

1  After writing an automation pass, stop the 
transport. The master Latch switch flashes when 
the automation for one or more controls can be 
resumed in Latch mode.

2  Use the Rewind button or the Selector tool to 
move the cursor back so that it is just before the 
stop location.

3  Resume playback.

4  At the point where you want to start writing 
automation, hold Control (Windows) or Com-
mand (Macintosh) and press the flashing master 
Latch switch.

Automation recording continues for all controls 
in Latch mode.
AutoJoin Function

The AutoJoin function is used in Latch mode to 
automatically resume writing of automation af-
ter the transport is stopped and started again 
during an automation pass.

The AutoJoin function can be used while work-
ing continuously in Latch mode, or after the au-
tomation mode changes to Latch mode from 
Write mode or Touch mode.

To automatically resume writing automation in 
Latch mode:

1  After writing an automation pass, stop the 
transport. The master Latch switch flashes when 
the automation for one or more controls can be 
resumed in Latch mode.

2  In the Automation Enable window, click the 
AutoJoin button. A red line, the AutoJoin Indi-
cator, appears in the Edit window to show the 
stop location. 

3  Use the Rewind switch or the Selector tool to 
move the cursor back so that it is just before the 
stop location.

4  Resume playback.

At the AutoJoin Indicator, automation record-
ing resumes automatically for all controls in 
Latch mode.
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Automation Write On Stop Modes

In Pro Tools 6.9, when any of the Write On Stop 
modes (Write to Start, End, All, or Next On Stop) 
is enabled, the chosen action is performed auto-
matically after a valid automation pass, and the 
Write On Stop mode is then disabled. 

Write On Stop modes can also be configured to 
remain enabled after a valid automation pass.

On ProControl with Edit Pack, the Write to 
Start, End, and All On Stop modes can be config-
ured from the Auto-Write section of the control 
surface.

To configure Automation Write On Stop modes to 
disable after an automation pass:

1  Hold Start (Windows) or Control (Macintosh) 
and press the Start, End, or All switch in the 
Auto Write section on the Edit Pack. The switch 
flashes to indicate that Write On Stop is enabled.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
stop playback.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection, and the Write on Stop mode 
is then disabled. The Start, End, or All switch 
stops flashing to indicate that the Write on Stop 
mode is disabled.
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To configure Automation Write On Stop modes to 
remain enabled after an automation pass:

1  Hold Start+Alt (Windows) or Control+Option 
(Macintosh) and press the Start, End, or All 
switch in the Auto Write section on the Edit 
Pack. The switch lights to indicate that Write on 
Stop is enabled.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
stop playback.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection, and the Write on Stop mode 
stays enabled. The Start, End, or All switch re-
mains lit to indicate that Write on Stop mode is 
enabled.



Pro Tools Solo Latch Options

ProControl supports the Solo Latch options in 
Pro Tools:

Latch When this option is selected, pressing 
subsequent channel Solo switches adds the 
channels to the Solo output.

X-OR When this option is selected, pressing a 
channel Solo switch unsolos any other chan-
nels.

Momentary When this option is selected, you 
can temporarily solo any number of channels by 
holding a single channel Solo switch and press-
ing any additional channel Solo switches. When 
you release the held Solo switch, all solos are 
cleared.

To solo more than one track at the same 
time in X-OR mode, press and hold a single 
Solo switch, then press additional Solo 
switches to latch them on.
Control|24 Features

Changing Playback Location

In Pro Tools 6.9, the following commands are 
available from Control|24:

Back Moves the playback location backward by 
the Back/Forward Amount.

Back and Play Moves the current playback loca-
tion backward by the Back/Forward Amount 
and automatically begins playback.

Forward Moves the playback location forward by 
the Back/Forward Amount.

Forward and Play Moves the current playback lo-
cation forward by the Back/Forward amount 
and automatically begins playback.

To move the playback location backward:

■ Hold Control (Windows) or Command (Mac-
intosh) and press the Rewind switch in the Con-
trol|24 Transport.

To move the playback location backward and 
begin playback:

■ Hold Control+Alt (Windows) or Com-
mand+Option (Macintosh) and press the Re-
wind switch in the Control|24 Transport.

To move the playback location forward:

■ Hold Control (Windows) or Command (Mac-
intosh) and press the Fast Forward switch in the 
Control|24 Transport.

To move the playback location forward and begin 
playback:

■ Hold Control+Alt (Windows) or Com-
mand+Option (Macintosh) and press the Fast 
Forward switch in the Control|24 Transport.
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Automation Commands

In Pro Tools 6.9, the following commands are 
available from Control|24:

AutoMatch Function

During playback, you can stop writing of auto-
mation on Write-enabled or Latch-enabled 
tracks and return automation to previously writ-
ten levels by ramping up or down according to 
the AutoMatch time.

To end an automation pass on a single Write- or 
Latch-enabled track with AutoMatch:

■ During playback, at the point where you want 
to stop writing automation on a track, press the 
Automation switch (“Auto”) on the channel.

The track stops writing automation and ramps 
back to the previous automation level. The 
length of the automation ramp is determined by 
the AutoMatch Time preference.

To end an automation pass on all tracks with 
AutoMatch:

■ During playback, at the point where you want 
to stop writing automation, hold Alt (Windows) 
or Option (Macintosh) and press the Automa-
tion switch (“Auto”) on a Write- or Latch-en-
abled channel.

All tracks in Write or Latch mode stop writing 
automation and ramp back to previous automa-
tion levels. The length of the automation ramp 
is determined by the AutoMatch Time prefer-
ence.
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Snap Back Function

During playback, you can stop writing of auto-
mation on Write-enabled or Latch-enabled 
tracks and return automation instantly to previ-
ously written levels, ignoring any AutoMatch or 
AutoGlide settings.

To end an automation pass on a single Write- or 
Latch-enabled track with Snap Back:

■ During playback, at the point where you want 
to stop writing automation on a track, hold 
Control (Windows) or Command (Macintosh) 
and press the Automation switch (“Auto”) on 
the channel.

To end an automation pass on all tracks with Snap 
Back:

■ During playback, at the point where you want 
to stop writing automation, hold Control+Alt 
(Windows) or Command+Option (Macintosh) 
and press the Automation switch (“Auto”) on a 
Write- or Latch-enabled channel.

Join Function

The Join function is used in Latch mode to man-
ually resume writing of automation after the 
transport is stopped and started again during an 
automation pass. 

The Join function can be used while working 
continuously in Latch mode, or after the auto-
mation mode changes to Latch mode from 
Write mode or Touch mode.

To manually resume writing automation in Latch 
mode:

1  After writing an automation pass, stop the 
transport. The master Latch switch flashes when 
the automation for one or more controls can be 
resumed in Latch mode.



2  Use the Rewind button or the Selector tool to 
move the cursor back so that it is just before the 
stop location.

3  Resume playback.

4  At the point where you want to start writing 
automation, hold Control (Windows) or Com-
mand (Macintosh) and press the flashing master 
Latch switch.

Automation recording continues for all controls 
in Latch mode.

AutoJoin Function

The AutoJoin function is used in Latch mode to 
automatically resume writing of automation af-
ter the transport is stopped and started again 
during an automation pass.

The AutoJoin function can be used while work-
ing continuously in Latch mode, or after the au-
tomation mode changes to Latch mode from 
Write mode or Touch mode.

To automatically resume writing automation in 
Latch mode:

1  After writing an automation pass, stop the 
transport. The master Latch switch flashes when 
the automation for one or more controls can be 
resumed in Latch mode.

2  In the Automation Enable window, click the 
AutoJoin button. A red line, the AutoJoin Indi-
cator, appears in the Edit window to show the 
stop location. 

3  Use the Rewind switch or the Selector tool to 
move the cursor back so that it is just before the 
stop location.

4  Resume playback.

At the AutoJoin Indicator, automation record-
ing resumes automatically for all controls in 
Latch mode.
Automation Write On Stop Modes

In Pro Tools 6.9, when any of the Write On Stop 
modes (Write to Start, End, All, or Next On Stop) 
is enabled, the chosen action is performed auto-
matically after a valid automation pass, and the 
Write On Stop mode is then disabled.

Write On Stop modes can also be configured to 
remain enabled after a valid automation pass.

On Control|24, the Write to Start, End, or All On 
Stop modes can be configured from the Write 
Automation To section of the control surface.

To configure Automation Write On Stop modes to 
disable after an automation pass:

1  Hold Start (Windows) or Control (Macintosh) 
and press the Start, End, or All switch in the 
Write Automation To section. The switch flashes 
to indicate that Write On Stop is enabled.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
stop playback.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection, and the Write on Stop mode 
is then disabled. The Start, End, or All switch 
stops flashing to indicate that the Write on Stop 
mode is disabled.
Chapter 3: What’s New In Pro Tools 6.9 Control Surfaces 61



62
To configure Automation Write On Stop modes to 
remain enabled after an automation pass:

1  Hold Start+Alt (Windows) or Control+Option 
(Macintosh) and press the Start, End, or All 
switch in the Write Automation To section. The 
switch lights to indicate that Write on Stop is 
enabled.

2  Click in a track to set an insertion point.

– or –

Drag with the Selector to select a portion of the 
track.

3  Start playback.

4  When you reach a point in the track that con-
tains the automation values you want to apply, 
stop playback.

The current values of all write-enabled automa-
tion are written to the corresponding area of the 
track or selection, and the Write on Stop mode 
stays enabled. The Start, End, or All switch re-
mains lit to indicate that Write on Stop mode is 
enabled.

Pro Tools Solo Latch Options

Control|24 supports the Solo Latch options in 
Pro Tools:

Latch When this option is selected, pressing 
subsequent channel Solo switches adds the 
channels to the Solo output.

X-OR When this option is selected, pressing a 
channel Solo switch unsolos any other chan-
nels.

To solo more than one track at the same 
time in X-OR mode, press and hold a single 
Solo switch, then press additional Solo 
switches to latch them on.
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Momentary When this option is selected, you 
can temporarily solo any number of channels by 
holding a single channel Solo switch and press-
ing any additional channel Solo switches. When 
you release the held Solo switch, all solos are 
cleared.

Command|8 Features
In Pro Tools 6.9, the following commands are 
available from Command|8:

AutoMatch Function

During playback, you can stop writing of auto-
mation on Write-enabled or Latch-enabled 
tracks and return automation to previously writ-
ten levels by ramping up or down according to 
the AutoMatch time.

To end an automation pass on a single Write- or 
Latch-enabled track with AutoMatch:

■ During playback, at the point where you want 
to stop writing automation on a track, hold 
Ctrl/Clutch and press the F4 switch on the 
channel.

The track stops writing automation and ramps 
back to the previous automation level. The 
length of the automation ramp is determined by 
the AutoMatch Time preference.

To end an automation pass on all tracks with 
AutoMatch:

■ During playback, at the point where you want 
to stop writing automation, hold Alt 
+Ctrl/Clutch (Windows) or Option+Ctrl/Clutch 
(Macintosh) and press the F4 switch on a Write- 
or Latch-enabled channel. 



All tracks in Write or Latch mode stop writing 
automation and ramp back to previous automa-
tion levels. The length of the automation ramp 
is determined by the AutoMatch Time prefer-
ence.

Snap Back Function

During playback, you can stop writing of auto-
mation on Write-enabled or Latch-enabled 
tracks and return automation instantly to previ-
ously written levels, ignoring any AutoMatch or 
AutoGlide settings.

To end an automation pass on a single Write- or 
Latch-enabled track with Snap Back:

■ During playback, at the point where you want 
to stop writing automation on a track, hold 
Ctrl/Clutch+Command and press the F4 switch 
on the channel.

To end an automation pass on all tracks with Snap 
Back:

■ During playback, at the point where you want 
to stop writing automation on a track, hold 
Ctrl/Clutch+Command+Alt (Windows) or 
Ctrl/Clutch+Command+Option (Macintosh) 
and press the F4 switch on a Write- or Latch-en-
abled channel.
Pro Tools Solo Latch Options

Command|8 supports the Solo Latch options in 
Pro Tools:

Latch When this option is selected, pressing 
subsequent channel Solo switches adds the 
channels to the Solo output.

X-OR When this option is selected, pressing a 
channel Solo switch unsolos any other chan-
nels.

Momentary When this option is selected, you 
can temporarily solo any number of channels by 
holding a single channel Solo switch and press-
ing any additional channel Solo switches. When 
you release the held Solo switch, all solos are 
cleared.

To solo more than one track at the same 
time in X-OR mode, press and hold a single 
Solo switch, then press additional Solo 
switches to latch them on.
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chapter 4

Support for Avid Video on Pro Tools|HD 
Systems with Pro Tools 6.9
New Features for Avid DNA 
Video Peripherals 
(AVoption|V10 and Avid Mojo)
Pro Tools 6.9 adds the following new features 
for Pro Tools users with either the Digidesign 
AVoption|V10 or the Avid Mojo™ (referred to 
here as Avid DNA video peripherals):

• New Movie track options

• Digitize video to Pro Tools Timeline

• Import, playback, edit, and export MXF au-
dio files

• AAF sequences may reference Sound De-
signer II audio files 

• Import OMF/AAF files with mixed sample 
rates and/or bit depths

• Optimizations for synchronization, Re-
mote mode, and record allocation

• Support for new Avid Media Station|PT 
software
Chapter 4: Support fo
New Movie Track Options
In Pro Tools 6.9, the Movie Track includes the 
following:

• Record Enable and Offline buttons

• Video Selectors and displays in the In-
put/Output View

Addition of Record Enable and 
Offline Buttons to Movie Track

In Pro Tools 6.9, the Movie track includes 
Record Enable and Offline buttons.

See “Digitizing Video to the Pro Tools 
Timeline” on page 67 for more details on 
capturing video in Pro Tools.

Movie Track

Record Enable button

Offline button
r A
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Record Enable Button

The Record Enable button lets you arm the 
Movie Track for digitizing video to the Timeline.

Offline Button

The Offline button duplicates the function of 
the Offline command in the Movie Menu. 
Clicking the Offline button lets you play back 
the audio in your session without playing back 
the video. When the video is offline, the Offline 
button changes to orange so you can tell at a 
glance whether your video is offline or simply 
playing black fill. Both the Offline button and 
the Offline menu command are disabled while 
your session is playing.

Additions to Input/Output View 
for Movie Track

In Pro Tools 6.9, the I/O View for the Movie 
track has Input, Output, and Video Record Vol-
ume Selectors, as well as a display for the current 
video output format (NTSC or PAL) and avail-
able record time.

Control-clicking (Windows) or Option-
clicking (Macintosh) an audio track’s 
Record Enable button does not arm the 
Movie track for recording.

Movie Track Input/Output View

Video Input Selector

Video Output Selector

Current video format

Video Record Volume

Approximate Minutes
Available indicator
What’s New in Pro Tools TDM 6.9
To show the I/O View:

• Choose Display > Edit Windows Shows > I/O 
View.

Video Input Selector

The Video Input Selector lets you choose from 
the following video inputs on an Avid DNA 
video peripheral:

• Component

• Composite

• S-Video

• SDI (AVoption|V10 only)

Video Output Selector

The Video Output Selector lets you choose from 
the following video outputs for an Avid Mojo: 

• Component

• S-Video + Composite

Current Video Format

The I/O View displays the current session’s 
video format (NTSC or PAL) as designated in the 
Session Setup window.

Video Record Volume Selector

The Video Record Volume Selector lets you se-
lect one volume at a time for video recording. 
Volumes that are not designated as record vol-
umes in the V column of the Workspace browser 
will not be available in this list. 

For details on using the Input/Output view 
with the Movie track, see “Digitizing Video 
to the Pro Tools Timeline” on page 67.

For AVoption|V10, all outputs are active at 
all times.



Approximate Minutes Available

When the Record Enable button is enabled in 
the Movie track, this indicator shows the ap-
proximate recording time (in minutes) available 
on the volume shown in the Video Record Vol-
ume Selector. This display does not update 
while video is being digitized.

Digitizing Video to the 
Pro Tools Timeline
Pro Tools 6.9 with Avid DNA video peripherals 
lets you digitize video directly to the Movie 
track for use in the Pro Tools editing environ-
ment. 

Video is digitized in the Avid DV25 file format, 
and may be used in the Movie track along with 
OMF and MXF video clips of other resolutions 
that are from other sources. Though the video 
files which are captured in Pro Tools are techni-
cally MXF files, they are intended only for use in 
Pro Tools. They have not been tested for import 
into other applications, and may not be of stan-
dard broadcast quality.

QuickTime video clips cannot be mixed 
with OMF or MXF video clips in the Movie 
track.

Up to six hours of video can be digitized in 
a single record pass.

Each record pass can only record to a single 
volume (or a set of striped drives). One video 
file cannot be recorded across multiple vol-
umes.
Chapter 4: Support fo
Hardware Requirements and 
Options

SYNC I/O Requirement

For digitizing video, Pro Tools 6.9 requires a 
SYNC I/O locked to video reference.

For information about setting up SYNC I/O 
hardware and locking the SYNC I/O to video ref-
erence, see the SYNC I/O User’s Guide.

To configure SYNC I/O for digitizing video in 
Pro Tools:

1  Ensure that the SYNC I/O is locked to the ap-
propriate video reference for your system setup. 
For more information, see the SYNC I/O Guide or 
the MachineControl Guide.

2  In the Session Setup window (Windows > Ses-
sion Setup), select SYNC I/O from the Clock 
Source pop-up menu.

3  Under the SYNC Setup & Time Code Offsets 
section, ensure that Video Reference is displayed 
in the Clock Reference pop-up menu.

Session Setup window Clock Source selection

Session Setup window Video Format selection
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4  Choose NTSC or PAL from the Video Format 
pop-up menu. The Video format you choose is 
reflected in the Movie track’s I/O View.

5  Under the Time Code Settings section, ensure 
the Using SYNC option is deselected for digitiz-
ing video.

Timebase Correction

Avid DNA video peripherals require that all 
sources be timebase corrected. Most professional 
video decks have built-in timebase correction. 
To find out if your video deck has built-in time-
base correction, refer to the manufacturer’s doc-
umentation.

Movie Track Input/Output View

Session Setup window Time Code Settings section

Current Video Format
What’s New in Pro Tools TDM 6.9
MachineControl

You can use Digidesign MachineControl soft-
ware (purchased separately) to remotely control 
your external video deck during Pro Tools cap-
ture. When recording to the Movie track with 
MachineControl, it is recommended that the 
Track View be set to Blocks.

Configuring the Movie Track for 
Digitizing

To configure the Movie track for digitizing:

1  Choose Movie > New Avid Movie Track to cre-
ate a new Movie track.

2  In the Edit window, with I/O View enabled, 
use the Movie track's Input Selector to assign 
one of the following video inputs:

• Component

• Composite

• S-Video

• SDI (AVoption|V10 only)

Digidesign MachineControl does not con-
trol FireWire-connected devices. For auto-
mated capture with FireWire devices, use 
Avid Media Station|PT software.

For more information, see the Machine-
Control Guide.

Selecting Video Input from the Video Input Selector



3  For Avid Mojo, use the Movie track's Output 
Selector to assign one of the following video 
outputs.

• Component

– or –

• S-Video + Composite.

4  Select the video record volume from the Video 
Record Volume Selector. 

Pro Tools will create a Video Files folder in the 
session folder on the video record volume. If 
this volume is different than the volume on 
which your session was originally saved, Pro 
Tools will also create a new session folder on the 
target volume matching the name of the current 
session.

For AVoption|V10, all outputs are active at 
all times.

Clicking the Record Enable button in the 
Movie track will display the approximate re-
cording time available (in minutes) under 
the Video Record Volume Selector. 

Selecting drives for video capture
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To digitize video to the Movie track:

1  In the Edit window, do one of the following:

• Place the Playback cursor where you want 
to start recording.

– or –

• Make a selection on a Timebase Ruler or on 
a track to select a range of time for the re-
cording. (To make a selection on a track, 
Operations > Link Edit and Timeline Selec-
tion must be enabled.)

2  Record enable the Movie track by clicking the 
Record Enable button. The approximate record-
ing time available on the selected video record 
volume will be displayed (in minutes) below the 
Video Record Volume Selector. This display does 
not update while video is being digitized.

If you want to digitize video without speci-
fying a selection in the Timeline, the video 
record volume must have at least 200 MB of 
available space. You can also limit the 
amount of recording time by changing the 
Open Ended Record Allocation settings (lo-
cated in Setups > Preferences > Operations).

Because it is not possible to record a partial 
frame of video, selections in the Movie track 
are rounded to the frame boundaries. This 
means that the start of the selection is 
moved earlier to the nearest frame boundary 
and the end of the selection is moved later to 
the next frame boundary.
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3  Do one of the following:

• To record with the video’s time code syn-
chronized to the session time code when 
the MachineControl option is installed, 
click the Online button in the Transport 
window to enable it, then click Record in 
the Transport window. The VTR will locate 
to the correct time code and begin record-
ing.

• To record with the video’s time code syn-
chronized to the session time code when 
the MachineControl option is not installed, 
first slave Pro Tools to incoming LTC or 
VITC time code, then click the Online and 
Record buttons in the Transport window. 
Manually start playback on the VTR to be-
gin recording.

• To record video without synchronizing to 
time code, ensure the Online button in the 
Transport window is not enabled. Manu-
ally start playback on the VTR, then click 
Record and Play in the Transport window 
to begin recording.

See the Pro Tools Reference Guide for infor-
mation about slaving to LTC or VITC time 
code.

Transport window

Online
button
What’s New in Pro Tools TDM 6.9
4  When you have finished recording, click Stop 
in the Transport window.

To abort a record pass:

• Press Control+period (Windows) or Com-
mand+period (Macintosh) to abort a record 
pass in progress and restore the Movie track to 
its original state. The video that you digitized 
before aborting will be deleted from disk.

To undo a record pass:

• Choose Movie > Undo Capture to undo a 
record pass after it has completed. The digi-
tized video will be removed from the Movie 
track, and any video clips that were overwrit-
ten in the Movie track will be restored.

When you undo a record pass, the digitized 
video will be removed from the Movie track, but 
will not be removed from disk.

Dropouts During Video Digitize

When recording video, a dropout may occur in 
the video signal. Dropouts can be caused by bad 
cable connections, dropouts in the source tape, 
or other problems. When Pro Tools detects a 
dropout in the video signal while recording, a 
warning dialog appears. The recording will con-
tinue as specified and may still be usable. 

If you record over existing clips in the Movie 
track, the actual video files remain intact. 
All video recording in Pro Tools is non-de-
structive.



Because the Location Indicators freeze when the 
warning dialog appears, it is recommended that 
you make a note of the location shown in the 
indicators before dismissing the dialog, then do 
the following:

• Check the recorded video near that loca-
tion to see if the error caused an unaccept-
able dropout. 

• Check the video recorded after the initial 
dropout, as the warning is only posted for 
the first occurrence and there may be other 
errors later in the recording.

Importing, Editing, and 
Exporting MXF Audio Files
Pro Tools 6.9 adds the following support for 
MXF audio:

• Import and play back MXF audio and video 
files

• Export MXF audio files (DigiTranslator 2.0 
required)

MXF (Material Exchange Format) is a media file 
format that includes both video and audio files, 
and is designed for the interchange of audio-vi-
sual material with associated data and metadata. 
It was designed for improving file-based in-
teroperability between servers, workstations, 
and other content creation devices.

AAF sequence files can refer to MXF media files. 
For AAF or OMF sequence information and re-
quirements, see the DigiTranslator 2.0 Guide, or 
the Avid DNA Video Peripherals Guide.

Pro Tools cannot play MXF audio or video 
files embedded in an AAF sequence.
Chapter 4: Support fo
Importing MXF Audio into 
Pro Tools

Pro Tools 6.9 now lets you import MXF audio 
files using any of the following procedures:

• File > Import Audio to Track

• Import Audio command in the Audio 
menu from the Audio Regions List

• Drag files to the Pro Tools application icon 
or alias

• Drag from a DigiBase browser

For information on importing audio files, see 
the Pro Tools Reference Guide.

Editing MXF Audio in Pro Tools

MXF audio can be edited in the same way as 
other types of audio files, with some minor lim-
itations. MXF audio does not support:

• Destructive editing

• Editing with the Pencil tool

• AudioSuite plug-ins Overwrite Files option

MXF Audio Metadata Display in 
DigiBase Browsers

In Pro Tools 6.9, DigiBase browsers display the 
same types of metadata for MXF-wrapped audio 
and video files that are displayed for OMF media 
files.

DigiTranslator is not required to import and 
play back MXF audio.

For more information on using the Pro 
Tools DigiBase browsers, see the DigiBase 
Guide.
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Exporting Pro Tools Tracks as MXF 
Audio Files

With the DigiTranslator 2.0 option installed, 
you can choose to export MXF audio files using 
the following commands:

• Export Selected Tracks as OMF/AAF

• Export Selected Regions as Files

• Bounce to Disk

Exporting Tracks with MXF Audio Files

Use Export Selected Tracks as OMF/AAF to ex-
port individual tracks or an entire Pro Tools ses-
sion as an AAF sequence referring to MXF audio 
files.

To export selected audio tracks from Pro Tools as 
an AAF sequence referring to MXF audio files:

1  In Pro Tools, select the tracks you want to ex-
port.

2  Choose File > Export Selected Tracks as 
OMF/AAF.

Tracks are exported in their entirety and 
time selections are ignored.

Volume and pan automation is not ex-
ported if Quantize Edits to Frame Bound-
aries or Avid Compatibility Mode are en-
abled.

Selecting a track in Pro Tools
What’s New in Pro Tools TDM 6.9
3  Under OMF/AAF Options, choose AAF from 
the Export As pop-up menu.

4  Select Enforce Avid Compatibility.

5  Ensure the Target project time code format is 
correct for the Avid application project to which 
you are exporting the AAF sequence. 

6  Under the Audio Media Options section, se-
lect MXF from the Audio Format pop-up menu.

An OMF sequence cannot reference MXF 
media files. When using the Export Selected 
Tracks as OMF/AAF dialog, choose AAF in 
the Export As pop-up menu to enable MXF 
in the Audio Format menu.

Enforce Avid Compatibility creates frame-
accurate edits, wraps the files as OMFI (un-
less you choose MXF), and limits the sam-
ple rate options to 44.1 or 48 kHz. Dither-
ing without noise shaping will be applied to 
files being exported from 24-bit to 16-bit.

Pro Tools Export to OMF/AAF dialog



7  Verify the Audio Bit-Depth setting is accept-
able for the recipient of this export. Many ver-
sions of Avid editors only support 16-bit audio. 
However, all versions of Media Composer 
Adrenaline editors and Avid Xpress Pro versions 
4.5 or later support 24-bit audio.

8  Click OK. 

9  In the Publishing Options dialog, type the 
Pro Tools Comment and Sequence Name. 

Pro Tools will create a sequence with the name 
you supply. The comment appears in the Avid 
application bin in the Pro Tools Comment col-
umn.

10  Click OK.

11  In the Name the AAF File to Export dialog, 
navigate to a folder where you can easily locate 
the AAF sequence when it is time to import it 
into the Avid application.

12  Click Save.

Pro Tools Publishing Options dialog

Pro Tools Name the AAF File to Export dialog (OMFI 
dialog not shown)
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13  In the Please Choose a Folder for Converted 
Audio Files dialog, ensure that the audio files are 
being saved to the OMFI MediaFiles folder (OMF 
files) or the Avid MediaFiles folder (MXF files) 
on a suitable drive for use with the target Avid 
application.

14  Click Use Current Folder (Windows) or 
Choose (Macintosh).

Pro Tools exports the AAF sequence to the de-
sired folder, and exports the related media to the 
OMFI MediaFiles folder (OMFI files) or the Avid 
MediaFiles folder (MXF files).

15  If you are ready to import the files into the 
Avid application, exit Pro Tools.

Exporting a Region as a New MXF File

You can export regions as MXF audio files with 
the Export Selected As Files command. Use this 
command if you intend to use a region in other 
sessions or other audio applications without us-
ing its parent source file. 

This command also provides a way to convert 
regions to a different sample rate or bit depth.

Navigating to the OMFI MediaFiles folder

For more information on working in Avid 
applications, see the appropriate Avid ap-
plication guide or the Avid Media Station|PT 
Guide.
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To export regions as new MXF files:

1  In the Audio Regions List, select the regions 
you want to export.

2  From the Audio Regions List pop-up menu, 
choose Export Selected As Files.

3  In the Export Selected dialog, select the En-
force Avid Compatibility option.

4  Select MXF from the File Type pop-up menu.

5  Set the bit resolution and sample rate. In ad-
dition, specify the Conversion Quality and Des-
tination Directory.

Export Selected dialog

Enforce Avid Compatibility creates frame-
accurate edits, wraps the files as OMFI (un-
less you choose MXF), and limits the sam-
ple rate options to 44.1 or 48 kHz. Dither-
ing without noise shaping will be applied to 
files being exported from 24-bit to 16-bit.
What’s New in Pro Tools TDM 6.9
6  In the Rename By section, click one of the fol-
lowing options to indicate how Pro Tools 
should resolve duplicate file names:

Prompting for Each Duplicate Prompts you for a 
file name for any file that has the same name as 
a file in your destination directory. 

Auto Renaming Automatically changes the 
name of any duplicate file by adding a number 
at the end of the file name (such as file_01). 

Replacing with New Files Replaces files with the 
same name with the new files.

7  Click Export to export the new audio files.

When you use the Export Selected As Files 
command with a lower bit rate, Dither (and 
Noise Shaping) may be applied as shown in 
Table 5.

Table 5. Dither and Noise Shaping with Export Selected 
dialog

Bit Rate Dither
Noise 
Shaping

24-bit to 24-bit No No

16-bit to 24-bit No No

24-bit to 16-bit Yes Yes

16-bit to 16-bit No No

24-bit to 8-bit Yes No

16-bit to 8-bit Yes No

For more information about using Dither, 
see the Pro Tools Reference Guide.



Exporting MXF Audio Files Using 
Bounce to Disk

Use the Bounce to Disk command to create pre-
mixed MXF audio files of the current Pro Tools 
session. This does not export all of the individ-
ual files on the Timeline, but it does guarantee 
that the mix you hear in another application 
will be identical to the mix you hear in 
Pro Tools, including all panning, effects and au-
tomation.

To export to MXF using Bounce to Disk:

1  After you have finished recording and mixing 
a session in Pro Tools, highlight the length of 
the session in the timeline ruler (or on a track), 
plus an additional amount of time to avoid cut-
ting off any reverb tails that might continue 
past the end of the region.

2  Choose File > Bounce to Disk.

Audio session highlighted and ready to bounce
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3  In the Bounce Options dialog, choose your 
Bounce Source. 

4  Select Enforce Avid Compatibility.

5  Choose MXF for the File Type.

6  Choose a Sample Rate and Bit Depth. 

7  Click Bounce.

8  In the Publishing Options dialog, type the 
Pro Tools Comment and Clip Name.

All audible audio in the selection will be ex-
ported to two multi-mono audio files.

9  In the Save Bounce As dialog, choose the drive 
where you want to save the files.

10  Click Save.

Pro Tools Bounce to Disk dialog

Enforce Avid Compatibility creates frame-
accurate edits, wraps the files as OMFI (un-
less you choose MXF), and limits the sam-
ple rate options to 44.1 or 48 kHz. Dither-
ing without noise shaping will be applied to 
files being exported from 24-bit to 16-bit.
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Pro Tools will begin bouncing to disk. Pro Tools 
bounces are done in real time, so you hear audio 
playback of your mix during the bounce process 
(though you cannot adjust it).
.

Support for AAF Sequences 
Referencing SDII Audio Files
Pro Tools can now import an AAF sequence that 
references Sound Designer II (SDII) audio files.

Importing OMF/AAF Audio 
Files with Mixed Sample 
Rates and/or Bit Depth
With the DigiTranslator 2.0 option, you can 
open and import OMF or AAF sequences with 
mixed audio sample rates and/or bit-depths into 
Pro Tools.

Bouncing to Disk dialog

Pro Tools cannot import any audio or video 
files embedded in AAF sequences.

For more information on importing and ex-
porting AAF sequences, see the Pro Tools 
Reference Guide or the Avid Media Sta-
tion|PT Workflow Guide.
What’s New in Pro Tools TDM 6.9
Audio files that are not of the same bit depth or 
sample rate as a session must be converted to be 
used with the session. When an audio file is con-
verted, a new file with the correct bit depth, file 
type, and sample rate is created and placed in a 
folder you choose.

Optimizations for 
Synchronization, Remote 
Mode, and Record Allocation
Pro Tools 6.9 contains enhancements that im-
prove lock time and reliability when synchro-
nizing to external time code. In addition, record 
start times are improved in non-synchronized 
workflows.

Redefine External Time Code 
Offset Command

The new Redefine External Time Code Offset 
command (located in the Setup menu) makes it 
easy to recalculate time code offsets based on 
the current selection. This is particularly useful 
when synchronizing to a new picture cut that 
may have different time code from the original 
session.

You can use the Source Sample Rate settings 
to compensate for any pull up or pull down 
factors that may have been applied to the 
audio prior to importing. (See the Pro Tools 
Reference Guide for more information on 
using the Sample Rate Conversion settings.) 
In a sequence with files of mixed sample 
rates, set the Source Sample Rate in propor-
tion to the Target sample rate of the session, 
and the pull up or pull down compensation 
will be applied correctly to all files in pro-
portion with their original sample rate.



To redefine the external time code offsets:

1  Set the Edit mode to Grid.

2  Set the Grid value to Timecode, with a unit 
setting of 1 frame.

3  Click the selector at a frame boundary where 
you can easily identify a picture sync point (for 
example, at the start of picture or an edit).

4  Choose Setups > Redefine External Time Code 
Offset.

5  Enter the new time code position for the pic-
ture sync point you chose.

6  Click OK.

Redefine External Time Code Offset dialog
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After you redefine the time code offset, the off-
set automatically updates in the Sync field un-
der the External Time Code Offsets section of 
the Session window.

Changes to Minimum Sync Delay

The Minimum Sync Delay preference (located in 
Setups > Peripherals > Synchronization) should 
not have to be adjusted during normal use, as 
Pro Tools will now automatically adjust for op-
timal lock times.

Pro Tools now keeps track of lock time “his-
tory,” then automatically optimizes play and 
record “priming” (pre-loading audio or pre-allo-
cating disk space for recording) in order to get 
the fastest, most consistent lock time possible.

The Minimum Sync Delay preference now sets 
the minimum time for only the first learning 
pass.

Pro Tools will reset its lock time to the Mini-
mum Sync Delay amount when there have been 
significant changes in the amount of record-
enabled tracks, or if video is taken online or of-
fline. Pro Tools then re-optimizes for best and 
most consistent lock times and ignores the Min-
imum Sync Delay until there is another reset. 

External Time Code Offsets section in Session Setup 
window

In order to maintain acceptable lockup 
times, do not TrackPunch-enable more 
tracks than necessary.

Offset automati-
cally updated
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New Avid Media Station|PT 
Software
Avid Media Station|PT software is designed es-
pecially for Pro Tools post-production work-
flows with AVoption|V10 and Avid Mojo. Media 
Station|PT replaces Media Station|V10 and adds 
the following features:

• Send to Pro Tools Export templates

• Video mixdown

• MXF audio support

• Import, playback, and export of all MXF video 
resolutions

• Support for Avid Mojo on Windows XP and 
Mac OS X, including:

• Capture and playback of Mojo-supported 
resolutions 

• Capture audio from 192 I/O audio interface

• Transcode non-Avid Mojo resolutions to 
DV25 for import to Pro Tools

New AVoption|V10 Features
(Windows XP Only)

Pro Tools 6.9 with the 192 I/O or 
192 Digital I/O audio interface supports the fol-
lowing Avid video features for AVoption|V10:

• Import and playback of any standard-defi-
nition Avid MXF Video file

• Import and playback of IMX MPEG50 
video files 

• Optical connections between AVop-
tion|V10 and audio interface no longer re-
quired

For more information about these features, 
see the Media Station|PT Guide.
What’s New in Pro Tools TDM 6.9
Import and Playback of Any 
Standard-Definition Avid MXF 
Video File

Pro Tools 6.9 with AVoption|V10 adds the abil-
ity to import and play back any resolution of 
MXF video.

For information on importing and playing back 
video files in Pro Tools, see the Pro Tools Refer-
ence Guide.

Importing and Playing Back IMX 
MPEG50 Video Files

Pro Tools 6.9 with AVoption|V10 lets you im-
port and play back IMX MPEG50 video with an 
OMF or MXF metadata wrapper.

OMF- or MXF-wrapped IMX MPEG50 video files 
can also be imported as part of an AAF file that is 
referencing audio and video media.

To import an IMX video file into Pro Tools:

1  Launch Pro Tools and create a new session, or 
open an existing one.

2  Check the time code settings of the session to 
make sure they match those of the movie you 
want to import, and save the session.

MPEG40, MPEG30, and OP1a format IMX 
files are not supported.



3  Choose Movie > Import Movie. 

4  In the Select Video File to Import dialog, select 
OMF or MXF in the Files of Type menu, and nav-
igate to the drive and folder that contains the 
file you want to import.

5  Select the movie and click Open. Pro Tools im-
ports the movie and displays it in its own Movie 
track in the Edit window.

Optical Connections Between 
AVoption|V10 and Audio Interface 
No Longer Required

To capture and play back audio with Media Sta-
tion|V10 software, it was necessary to connect 
the OPTICAL In and Out ports on the AVop-
tion|V10 to the OPTICAL In and Out ports on 
the Pro Tools audio interface.

With Media Station|PT, these optical cable con-
nections are no longer required. Audio is now 
captured directly through the audio peripheral.

Import Movie dialog

Movie track above an audio track in the Edit window
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New Avid Mojo Features
Pro Tools 6.9 with the 192 I/O or 
192 Digital I/O audio interface adds the follow-
ing Avid video features for Avid Mojo:

• Windows XP TDM support

• Avid Mojo support on Windows XP, in-
cluding streaming audio and video with 
Avid Unity MediaNetwork

Windows XP TDM Support

Avid Mojo is now supported by Pro Tools|HD 
on both Windows XP and Mac OS X.

Avid Unity Support for Mojo
(Windows XP Only)

Pro Tools 6.9 with AVoption|V10 or Avid Mojo 
supports Avid Unity™ MediaNetwork, which 
provides integrated high-speed network storage 
systems for Avid and Pro Tools workstations.

For detailed information on configuring your 
Pro Tools system with AVoption|V10 or 
Avid Mojo as an Avid Unity MediaNetwork cli-
ent, see the Pro Tools Client Avid Unity™ Medi-
aNetwork Guide. Also, refer to the Avid Unity 
compatibility pages of the Digidesign Web site 
(www.digidesign.com/compato), as well as your 
Avid Unity MediaNetwork documentation.

Recording to and Streaming Media 
from Unity

Both audio and video media can be recorded to 
and played back from Avid Unity storage vol-
umes.
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Digitizing Video Directly to Unity

You can digitize video directly to Avid Unity 
MediaNetwork by designating a Unity volume 
as the video record volume. For more informa-
tion, see “Digitizing Video to the Pro Tools 
Timeline” on page 67.

Video Rate Pull Up/Down No 
Longer Supported for Avid 
Video
When working with Avid video in previous ver-
sions of Pro Tools, the Video Rate Pull Up/Down 
pop-up menu located in the Session Setup win-
dow let you apply pull up or pull down factors 
to the frame rate of video playback indepen-
dently from the audio pull ups (if any).

This feature is not supported in Pro Tools 6.9 
with Avid video, and displays “None” in the 
Video Rate Pull Up/Down pop-up menu.
What’s New in Pro Tools TDM 6.9
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